If you are not using Excel 2016 for Apple Mac you need a different book

This Excel 2016 for Apple Mac book isn’t suitable for the Windows versions of Excel. You can download the
free Windows version of this book from the https://TheSmartMethod.com web site. If you are using an older

version of Excel for Apple Mac (2008 or 2011) you should upgrade to Excel 2016.

Make sure you are using the latest version of this free e-book

Excel 2016 for Mac is regularly updated with new features. When new features are added, we revise this
book to account for them. You can always download the most recent version of this book completely free of
charge from: https://TheSmartMethod.com.

Why you should use this free e-book

B Learning success is guaranteed. For over fifteen years, Smart Method® classroom courses have been
used by large corporations, government departments and the armed forces to train their employees.
This book has been constantly refined (during hundreds of classroom courses) by observing which skills
students find difficult to understand and then developing simpler ways of explaining them. This has
made the book effective for students of all ages and abilities. We have never had a student who has
failed to learn Excel after taking one of our courses.

B Itis up-to-date. The original version of Excel 2016 for Mac was released in July 2015. The Mac version of
Excel 2016 receives new updates every month, which can include new features and other significant
changes. We release an updated version of this book at least every 6 months. This means that the screen
grabs will exactly match what you see on your screen and the instructions will be easy to follow. It can
be very frustrating to try to learn Excel 2016 for Mac using an out-of-date book (as most are).

B It is the preferred choice for teachers. As well as catering for those wishing to learn Excel by self-study,
Smart Method® books have long been the preferred choice for Excel teachers as they are designed to
teach Excel and not as reference books. Books follow best-practice adult teaching methodology with
clearly defined objectives for each learning session and an exercise to confirm skills transfer. With single,
self-contained lessons the books cater for any teaching period (from minutes to hours).

B Tt is free (and you can print it). Because this book is free of charge, schools, colleges, universities and
businesses are able teach their students best-practice Excel skills without the substantial cost of
designing lesson plans or purchasing books. If printed copies are needed you can print them yourself, or
any copy shop can print books for you.

B Smart Method books are #1 best sellers. While this book is entirely free of charge, every paper printed
Smart Method® Excel book (and there have been ten of them starting with Excel 2007 for Windows) has
been an Amazon #1 best seller in its category. This provides you with the confidence that you are using a
best-of-breed resource to learn Excel.

B No previous exposure to Excel is assumed. You will repeatedly hear the same criticism of most Excel
books: “you have to already know Excel to understand the book”. This book is different. If you've never
seen Excel before, and your only computer skill is using a web browser, you’ll have absolutely no
problems working through the lessons. No previous exposure to Excel is assumed and everything is
explained clearly and in a simple way that absolutely any student, of any age or ability, can easily
understand.

B It focuses upon the everyday Excel skills used in the workplace. This free Basic Skills book will teach
you the basics without confusing you with more advanced, less used, Excel features. If you decide to
expand your Excel education, you'll be able to move on to other Smart Method® books (or e-books) in
this series to master even the most advanced Excel features.
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Learn Excel in just a few minutes each day (or in one five-hour sitting)

Excel is a huge and daunting application and you'll need to invest some time in learning the skills presented
in this book. This will be time well spent as you'll have a hugely marketable skill for life. With 1.2 billion
users worldwide, it is hard to imagine any non-manual occupation today that doesn’t require Excel skills.

This book makes it easy to learn at your own pace because of its unique presentational style. The book
contains 36 self-contained lessons and each lesson only takes a few minutes to complete.

You can complete as many, or as few, lessons as you have the time and energy for each day. Many learners
have developed Excel skills by setting aside just a few minutes each day to complete a single lesson. Others
have worked through the entire book in less than five hours.

Hardly anybody understands how to use every Excel feature

It is important to realize that Excel is probably the largest and most complex software application ever
created. Hardly anybody understands how to use every Excel feature and, for almost all business users, large
parts of Excel’s functionality wouldn’t even be useful.

Many learners make the fundamental error of trying to learn from an Excel reference book that attempts to
document (though not teach) everything that Excel can do. Of course, no single book could ever actually do
this. (There are some advanced Excel features that easily justify an entire book of their own).

This free Basic Skills book will teach you the basic Excel skills that are used every day, in offices all over the
world.

By the end of this free Basic Skills book you’'ll be completely comfortable creating your own formulas and to
make use of the functions available in Excel’s vast function library. You'll also have mastered many other
fundamental Excel skills such as AutoSum, AutoFill and Formula Autocomplete. You'll be confident in the
knowledge that you are using Excel’s features in the correct, best-practice, professional way and you’ll feel
really at home with Excel.
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If you decide to further expand your Excel education, you'll be able to use other books in this series to
master even the most advanced Excel features.

If you’d like to review the precise skills taught in each book you can view the full course outlines for
Essential Skills and Expert Skills at: https://thesmartmethod.com.
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Excel competence levels

Office workers who use Excel every day for a living generally only use (and only need) a tiny fraction of
Excel's enormous feature set.

Excel is a huge application with thousands of features. For most users it is a mistake to attempt to learn
every Excel feature but, instead, to learn Excel to a competence level that is appropriate for your needs.

Expert

Basic Skills

This is where you will be at the end of this book. You'll feel really comfortable with Excel. Even at Basic
Skills level you’ll have mastered many skills that most untrained Excel users are unable to use correctly.
You'll also be using the correct professional techniques rather than “muddling though” in the way that most
self-taught Excel users do. You'll be able to create your own formulas using functions from Excel’s vast
function library and have a complete mastery of fundamental Excel features such as AutoFill.

Essential Skills

At this level you will have excellent Excel skills, good enough to impress any employer, and your Excel skills
will be better than most office workers (even those with many years of experience). You'll be able to create
beautifully laid-out worksheets that will really impress. You'll also have mastered many advanced features
that few Excel users understand such as absolute and relative cell references, visualizations, advanced charts,
conditional formatting, date serial numbers, themes and cloud computing. You can see a full list of the lessons in
the Essential Skills book at: https://thesmartmethod.com.

Expert Skills

At Essential Skills level you'll be really, really good with Excel. If you want to join the tiny elite of power-
users who can do absolutely everything with Excel you can move to expert level and become a true Excel
guru.

This is a extremely high level of Excel competence that is very rarely found in the workplace (even amongst
top professionals). Your Excel skills will be greater and broader than almost all other Excel users and you
will understand (and be able to use) absolutely every Excel feature. You'll have a complete mastery of skills
that are often even a mystery to Excel power users such as Pivot Tables, what-if analysis, validations, solver,
macros and slicers. You can see a full list of the lessons in the Expert Skills course at:
https://thesmartmethod.com.
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Every lesson is presented on two facing pages

Pray this day, on one side of one sheet of paper, explain how the Royal Navy is prepared to meet the
coming conflict.
Winston Churchill, Letter to the Admiralty, Sep 1, 1939

Winston Churchill was aware of the power of brevity. The discipline of condensing thoughts into one side of
a single sheet of A4 paper resulted in the efficient transfer of information.

A tenet of our teaching system is that every lesson is presented on two facing sheets of A4. We’ve had to
double Churchill’s rule as they didn’t have to contend with screen grabs in 1939! If we can’t teach an
essential concept in two pages of A4 we know that the subject matter needs to be broken into two smaller
lessons.

How this book avoids wasting your time.

Over the years | have read many hundreds of computer text books and most of my time was wasted. The big
problem with most books is that I must wade through thousands of words just to learn one important
technique. If I don’t read everything I might miss that one essential insight.

Many presentational methods have been used in this book to help you to avoid reading about things you
already know how to do, or things that are of little interest to you.

There are now two versions of Excel
2016 (the pay-once Excel 2016 version

Learn Excel 2016 Expert Skills with The Smart Method

Lesson 3-28: Use the IFS

and the subscription Excel 365
version). Where there are differences
they are clearly documented.

~

the text when they can explain what
you need to do more clearly than
words alone.

sometimes provide precise instructions
about how to progress if the one-line
description is inadequate. Notes also
often include interesting information
about the current task.

When there is a sample file (or files) to
accompany a lesson, the file name will
be shown in a folder icon. You can
download the sample file set from:
https://TheSmartMethod.com

e

note

The IFS function is
only available in the

INA Excel 365 version of

oon Feb 16, 2016)

2016, you will not had

provides a better solution than
VLOOKUP.

It is easy to introduce errors
using IFS and SWITCH, as the
order in which the logic pairs
are listed is vital to the correct
operation of the function.

Tn almost all business situations
a VLOOKUP will provide a
better and more elegant
solution than the use of the IFS
or SWITCH function.

s ~

1p. | IFS Grades-1 I

function

If you have Excel 2016 (rather than Excel 365) you will not be able to
complete this lesson (see sidebar).

Exceff2ni In: Lesson 3-23: Use a VLOOKUP function for an inexact lookup, yvou used a

The IFS function was VLOOKUP function to return a grade from different pass mark
Screen grabs are provided in-line with intzoduced in the Excel 2016 percentages.

Version 1601 update (eleased In early 2016 Microsoft added a new IFS function to Excel 365. In this

lesson you will solve exactly the same problem posed in: Lesson 3-23: Lse
a VLOOKUP function for an inexact lookup, with a logic based (rather than
lookup based) solution.

1 Open IFS Grades-1 from your sample files folder.

to this function. A B C D E F
1 | Exam Results
2
If you want to progress through the hote 3 |Name Percentage Grade Percentage Grade
1 1 ’ 4 Johnny Caine 70% 0% Fail
course as quickly as possible you don’t VLOOKUP is still . P i it
have to read notes. (usually) a better 8 oty anen s e
solution than IF§ ey .
. 8 |Ozzy Dickens 95% 90% A*
Notes usually expand a little on the < o e g 3 iohnny Roberts w5
information given in the lesson text. \\A function (sidebar) I advised: This is an exact duplicate of the Grades-T sample file that you used
“Excel 2016 allows you to nest at the beginning of: Lesson 3-25: Use ¢ VLOOKUP function for an
f.;ﬁ];r\[cﬁ::‘:hup ;Jﬂ 64 levels 7 inexact lookup.
(which is 63 too manvy)”.
The new IFS and SWITCH 2 Usethe IFS function o calculate the grade for each student
If 1 dv k h d by defining grade data within the function
you a. rea y now how to do imﬁ) M;‘Plﬂ' alternative to Sometimes it may be better to “hard code” data (such as the
something 51mply read the bold text iy i — percentage grade thresholds) within the function itself. This
. . L ) . prevents users from accidentally deleting or changing the grade
for each step and ]ust doit. Step notes - n“ds;‘:fl_sr“c;[ma“ using the IFS percentage thresholds within the worksheet.
an functions

The argument against this approach is that the worksheet is more
difficult to maintain if grade thresholds change in the future.

1. Clickin cell C4.

2. Click: Formulas-»Function Library->Logical >IFS.
The Function Arguments dialog for the IFS function appears.
The IFS function accepts up to 127 Logical Test/Value pairs.

3. Enter the following pair of arguments:

Logical_test! | B4<60%

Value_if_truel  “Fail

B

The Logical Test is an expression that returns TRUE or FALSE.
In this case the test asks if Johnny Caine's percentage is less
than 60%.
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Learning by participation

Tell me, and I will forget. Show me, and I may remember. Involve me, and I will understand.

Confucius, Chinese teacher, editot, politician and philosopher (551-479 BC)

Confucius would probably have agreed that the best way to teach IT skills is hands-on (actively) and not
hands-off (passively). This is another of the principal tenets of The Smart Method® teaching method.

Research has backed up the assertion that you will learn more material, learn more quickly, and understand
more of what you learn if you learn using active, rather than passive methods.

For this reason, pure theory pages are kept to an absolute minimum with most theory woven into the hands-
on lessons, either within the text or in sidebars.

This echoes the teaching method used in Smart Method classroom courses where snippets of pertinent
theory are woven into the lessons themselves so that interest and attention is maintained by hands-on
involvement, but all necessary theory is still covered.

Session Three: Advanced Functions . .
Whenever something can easily go
As Johnny scored 70% the result 1s FALSE (as 70% is not less . .
than 60%). If Johnny had a percentage score of less than 60%, Wl”Ol’lg, or When the SUb]eCt text1s
e function would have retumed the texc“Fail’ L particularly important, you will see the
. Note that textual values must be placed in double quotation . .
Ls I_test1 <60%
ool ekl marks. If you omit to do this Excel will add them for you. lmportant 81debar' You ShOUId always
Value_if_truel “Fail” . .
o 4. Add Logical Test/Value pairs for the other grades (see si read important sidebars.
3t P g
Logical_test? | B4<70%
. 5. Click the OK button.
Value_if_true2 | "C

Logical_tests |B4<a0m Johnny Caine’s B grade is shown in cel

Value_if true3 | 6" 5 AueRllcell Chio theend of fhpringe Each lesson models a real-world
" All grades are now corry . . .

) |k business problem. You'll immediately
Value_if_trued A" D E F | i

e | [P Percentage Grade Percentage Grade A// appreciate the value and relevance of

= 2= 70% 8 0% Fail .
Value.if_trues A~ - oa%lc ao%lc each skill you learn.

6 Betty Anan 86% A 70% B
. / 7 Paris Winfrey 80% A 80% A
|mp0 rtant 8 |Ozzy Dickens 95% A* 90% A*
Excel recognizes text 3 USE the IFS function to calculate the grade for each student A goal of this book is not to waste your
as having a value in using the grade data defined in cells E3:F8. time by explaining any skill twice.
logical expressions ions i mn . .
gical exp b Delete the funcions in column & Sometimes you may forget something
If you try entering text into the 2. Add anew IFS function to cell C4. that has alread been Covered earlier in
iﬁzg:t?ﬁmﬂ:;c‘;ﬁ%t pe 3. Enter the following pair of Logical Test/Value arguments: th y
€ course.

A E N

3 |Mame Percentage Grade Logical test! B> SESS *

[ cae_feacup " Value if_truet | “Fail z Cross-references are extensively used,
Excel has evaluated this logic MNotice the use of an absolute reference for cell E5. Thisis // pointing you baCk to the IESSOH in
expression: needed to make sure that the formula AutoFills correctly. / Wthh the relevant SklIlS were learned
="teacup”>90% 1f you do not understand absolute references see: Lesson 1-10: :
__and has surprisingly Add percentage and running totals using Quick Analysis (sidebar). The CrOSS-references also help When
i TS 4. Add appropriate Logical Test/Value pairs for the other grades. you use this course as a reference book
This seems zling at first - . .
unti 52 xelized that (bebind 5. Click the OX button. but have forgotten the more basic skills
ihi sezves) el v cesgy 6. Autofill cell C4 down to the end of the :

e e utofill cell C4 down to the end of the range needed to complete each step.
implement alphabetical sorting, Exactly the same grade values are now shown. The difference
tnal v from the first approach is that the grades will change if the
almmef::‘;;m[ t;\:l::i:r:umher Percentage/Grade thresholds shown in cells E3:F8 change in
so that (in an A-Z sort} the future.
numbers will always come 4 Save your work as IFS Grades-2.
before text.
To work around this peculiarity

vou could add a new first
Logical Test/Value pair to ensure
that the value in column B was
numeric like this:

Logical_test! | ISNUMBER(B4)=FALSE

Value if_truet | “Eror
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We encourage you to print this free book

Unlike most e-books, this one isn’t locked to prevent printing (this is also true for all other Smart Method e-
Books). E-books can only be obtained and downloaded from https://TheSmartMethod.com (the publisher).

For classroom use we recommend that you print this book

While this book is useful for self-instruction, it is also ideal for teaching structured, objective-led, and highly
effective classroom courses. Even though you can read this book on an iPad*, personal computer or e-Book
reader, some students find it easier to use if you print it onto paper. You may legally print copies of this
book (for yourself or your students) with only two conditions:

1. You must print the book exactly as it is published and may not add or remove any book content or
copyright notices.

2. You may not make any charge of any sort for the books that you print. It is permissible, however, to give
free copies of the book to students who attend a free (or paid for) class or course.

For classroom courses you can obtain a professional-looking result by printing on both sides of the paper.
You can then punch the pages and place them into a binder. Make sure that odd pages appear on the right-
hand side. This enables each two-page lesson to be viewed without turning the page.

For a professional touch you can also put a color insert onto the front cover. Here’s how it then looks:

Learn

Excel 2016
Basic Skills

With The Smart Method

‘than five hours
with this
FREE book

You can find full instructions for printing and binding this free e-book (along with the color front and back
cover pages) at: https://thesmartmethod.com/printing-the-basic-skills-course.

You can obtain printed books for under four dollars.

According to Lyra Research it costs between $0.05 and $0.08 cents per page to laser print a single black and
white page. This means that it will cost between $6.00 and $9.60 to print this book yourself on a laser printer.

If you need five or more books you can save a considerable amount of money by ordering perfect-bound
paper printed books from ourselves using our not-for-profit printing service. At time of writing our cost
price (including free delivery to most world locations) was under $4.00 per book.

You can only order these not-for-profit books from: https://thesmartmethod.com/wholesale-printed-books.

These paper books are often used as free giveaways by employment agencies (for job applicants who need
Excel skills) and by employers (to empower their employees with basic Excel skills at minimal cost).

*If you are an iPad user you can add this e-book to your iBook library. The procedure for adding this e-book to your iBook library is detailed in a step-by-

step guide at: https://thesmartmethod.com/how-to-save-and-view-a-pdf-e-book-on-an-ipad.
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Introduction

Welcome to Learn Excel 2016 for Mac OS X Basic Skills With The Smart Method®. This book has been designed
to enable students to master Excel 2016 fundamentals by self-study. The book is equally useful as
courseware in order to deliver courses using The Smart Method® teaching system.

Smart Method publications are continually evolving as we discover better ways of explaining or teaching the
concepts presented.

Feedback

At The Smart Method® we love feedback — both positive and negative. If you have any suggestions for
improvements to future versions of this book, or if you find content or typographical errors, the author
would always love to hear from you.

You can make suggestions for improvements to this book using the online form at:

https://thesmartmethod.com/contact

Future editions of this book will always incorporate your feedback so that there are never any known errors
at time of publication.

If you have any difficulty understanding or completing a lesson, or if you feel that anything could have been
more clearly explained, we’d also love to hear from you. We’ve made hundreds of detail improvements to
our books based upon reader’s feedback and continue to chase the impossible goal of 100% perfection.

Downloading the sample files

In order to use this book it is sometimes necessary to download free sample files from the Internet.

The process of downloading the free sample files is explained step-by-step in: Lesson 1-7: Download the sample
files and open/navigate a workbook.

Problem resolution

If you encounter any problem using any aspect of the course you can contact us using the online form at:

https://thesmartmethod.com/contact

We'll do everything possible to quickly resolve the problem.

The Excel versions that were used to write this book

This edition was written using both the Excel 2016 for Mac perpetual license (the one-time payment version)
and Excel 2016 for Office 365 subscribers (semi-annual version Error! Unknown document property name.,
released on Error! Unknown document property name.). You'll discover which version your computer is
running in: Lesson 1-3: Check that your Excel version is up to date. In this book, the perpetual license version of
Excel is referred to as: Excel 2016 for Mac and the subscription version as Excel 365.

If you are using Excel 2007, Excel 2010, Excel 2013 or Excel 2016 for Apple Mac we have a free Basic Skills e-
book that matches your version available from: https://thesmartmethod.com.
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Typographical Conventions Used In This

Book

This guide consistently uses typographical conventions to differentiate parts of the text.

When you see this Here’s what it means

Click Line Color on the left-hand bar and then
click No line.

Italics are used to refer to text that appears in a
worksheet cell, an Excel dialog, on the ribbon,
or elsewhere within the Excel application.
Italics may sometimes also be used for
emphasis or distinction.

Click: #>File>Open...

51l Edit View Insert Form|

New Workbook |
New from Template... 3P

5 ca Open Recent : >

Move the cursor to the Menu Bar at the top of
the screen.

Click the File menu and click the Open...
option from the drop-down list.

Click: Home—~>Underline.

Home
L)
|, X ow Calibri (Body)
1 Copy -
Past :
] %' Format E - Hk‘

Click on the ribbon’s Home tab and then click
the Underline button (that’s the left-hand side
of the button, not the drop-down arrow next
to it).

Don’t worry if this doesn’t make sense yet.
You will cover the ribbon in depth in session
one.

Click: Home~>

Underline Drop Down->Double Underline.
u |+ o[ S [« A |~

U Underline

Click on the ribbon’s Home tab and then look
for the Font group. Click the drop-down arrow
next to the Underline button (that’s the right-
hand side of the button) within this group and
then choose Double Underline from the drop-
down list.

Click:

®>Excel>Preferences>
Formulas and Lists>Custom Lists>
Import

This is a more involved example.

1. Move the cursor to the Menu Bar at the
top of the screen.

2. Click the Excel menu and click Preferences
from the dropdown list.

3. Find the Formulas and Lists group in the
dialog and click the Custom Lists button.

Another dialog pops up.
4.  Click the Import button.

Type: European Sales into the cell.

Whenever you are supposed to actually type
something on the keyboard it is shown in bold
faced text.

Press <Cmd> + <Z>.

You should hold down the Cmd (88) key and
then press the Z key.
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When a lesson tells you to click a button, an

Y. AutoSum image of the relevant button will often be
shown either in the page margin or within the
text itself.

nOte If you want to read through the book as
quickly as possible, you don’t have to read

In Excel 2016 there are a

possible 16,585 columns and
1,048,476 rows. This is a great
improvement on earlier
versions.

notes.

Notes usually expand a little on the
information given in the lesson text.

important

Do not click the Delete button at

this point as to do so would
erase the entire table.

Whenever something can easily go wrong, or
when the subject text is particularly important,
you will see the important sidebar.

You should always read important sidebars.

tip
Moving between tabs

using the keyboard

You can also use the
<Cmd>+<PgUp> and
<Cmd>+<PgDn> keyboard

shortcuts to cycle through all of

the tabs in your workbook.

Tips add to the lesson text by showing you
shortcuts or time-saving techniques relevant
to the lesson.

The bold text at the top of the tip box enables
you to establish whether the tip is appropriate
to your needs without reading all of the text.

In this example, you may not be interested in
keyboard shortcuts so do not need to read
further.

anecdote

I ran an Excel course for a small
company in London a couple of

years ago...

Sometimes I add an anecdote gathered over
the years from my Excel classes or from other
areas of life.

If you simply want to learn Excel as quickly as
possible you can ignore my anecdotes.

trivia

The feature that Excel uses to

help you out with function calls

first made an appearance in
Visual Basic 5 back in 199 ...

Sometimes I indulge myself by adding a little
piece of trivia in the context of the skill being
taught.

Just like my anecdotes you can ignore these if
you want to. They won’t help you to learn
Excel any better!

The World’s Fastest
Cars

When there is a sample file (or files) to
accompany a lesson, the file name will be
shown in a folder icon. You can download the
sample file from:
https://thesmartmethod.com/sample-files.
Detailed instructions are given in: Lesson 1-7:
Download the sample files and open/navigate a
workbook.

© 2018 The Smart Method® Ltd
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How to use this course

This course utilizes some of the tried and tested techniques developed after teaching vast numbers of people
to learn Excel during many years teaching Smart Method classroom courses.

In order to master Excel as quickly and efficiently as possible you should use the recommended learning
method described below. If you do this there is absolutely no doubt that you will master the advanced Excel
skills taught in this book.

Three important rules

#1 - Complete the course from beginning to end

It is always tempting to jump around the course completing lessons in a haphazard way.
We strongly suggest that you start at the beginning and complete lessons sequentially.

That's because each lesson builds upon skills learned in the previous lessons and one of our goals is not to
waste your time by teaching the same skill twice. If you miss a skill by skipping a lesson you'll find the later
lessons more difficult, or even impossible to follow. This, in turn, may demoralize you and make you
abandon the course.

#2 If possible, complete a session in one sitting

The book is arranged into sessions and lessons.

You can complete as many, or as few, lessons as you have the time and energy for each day. Many learners
have developed Excel skills by setting aside just a few minutes each day to complete a single lesson.

If it is possible, the most effective way to learn is to lock yourself away, switch off your telephone, and
complete a full session, without interruption, except for a 15-minute break each hour. The memory process is
associative, and we've ensured that the lessons in each session are very closely coupled (contextually) with
the others. By learning the whole session in one sitting, you'll store all that information in the same part of
your memory and will find it easier to recall later.

The experience of being able to remember all of the words of a song as soon as somebody has got you
"started" with the first line is an example of the memory's associative system of data storage.

#3 Rest at least every hour

In our classroom courses we have often observed a phenomenon that we call "running into a wall". This
happens when a student becomes overloaded with new information to the point that they can no longer
follow the simplest instruction. If you find this happening to you, you've studied for too long without a rest.

You should take a 15-minute break every hour (or more often if you begin to feel overwhelmed) and spend it
relaxing rather than catching up with your e-mails. Ideally you should relax by lying down and closing your
eyes. This allows your brain to use all of its processing power to efficiently store and index the skills you've
learned. We've found that this hugely improves retention of skills learned.
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How to work through the lessons

At the end of each session, complete the session exercise

Keep attempting the exercise at the end of each session until you can complete it without having to refer to
lessons in the session. Don't start the next session until you can complete the exercise from memory.

At the end of each session, review the objectives

The session objectives are stated at the beginning of each session.

Read each objective and ask yourself if you have truly mastered each skill. If you are not sure about any of
the skills listed, revise the relevant lesson(s) before moving on to the next session.

You will find it very frustrating if you move to a new session before you have truly mastered the skills
covered in the previous session. This may demoralize you and make you abandon the course.

How to best use the incremental sample files

Many lessons in this course use a sample file that is incrementally improved during each lesson. At the end
of each lesson an interim version is always saved. For example, a sample file called Sales-1 may provide the
starting point to a sequence of three lessons. After each lesson, interim versions called Sales-2, Sales-3 and
Sales-4 are saved by the student.

A complete set of sample files (including all incremental versions) are provided in the sample file set. This
provides three important benefits:

e If you have difficulty with a lesson it is useful to be able to study the completed workbook (at the
end of the lesson) by opening the finished version of the lesson's workbook.

e  When you have completed the book, you will want to use it as a reference. The sample files allow
you to work through any single lesson in isolation, as the workbook's state at the beginning of each
lesson is always available.

e  When teaching a class one student may corrupt their workbook by a series of errors (or by their
computer crashing). It is possible to quickly and easily move the class on to the next lesson by
instructing the student to open the next sample file in the set (instead of progressing with their own
corrupted file or copying a file from another student).

The time you spend learning Excel is hugely worthwhile

Excel is a huge and daunting application and you'll need to invest some time in learning the skills presented
in this course. This will be time well spent as you'll have a hugely marketable skill for life. With 1.2 billion
users worldwide, it is hard to imagine any organization of any size that does not value Excel skills.

If you persevere with this course there is no doubt that you will master Excel. A little time and effort is
needed but the skills you'll acquire will be hugely valuable for the rest of your life.

Enjoy the course.

© 2018 The Smart Method® Ltd 15






Session One: Basic Skills

A bad beginning makes a bad ending.
Euripides, Aegeus (484 BC - 406 BC).

Even if you are a seasoned Excel user, I urge you to take Euripides’
advice and complete this session. You'll fly through it if you already
know most of the skills covered.

In my classes I often teach professionals who have used Excel for over ten
years and they always get some nugget of fantastically useful information
from this session.

In this session I teach you the absolute basics you need before you can
start to do useful work with Excel 2016.

I don’t assume that you have any previous exposure to Excel (in any
version) so I have to include some very basic skills.

Session Objectives

By the end of this session you will be able to:

Configure your mouse and understand right clicking

Start Excel and open a new blank workbook

Check that your Excel version is up to date

Change the Office Theme

Minimize, re-size, move and close the Excel window
Understand Full Screen view

Download the sample files and open/navigate a workbook
Save a workbook to a local file

Understand common file formats

Pin a workbook and understand file organization

View, move, add, rename, delete and navigate worksheet tabs
Use the ribbon

Customize the Quick Access Toolbar and preview the printout
Understand ribbon components

Understand views

Hide and show the Formula Bar and ribbon

Use the help search system
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note

If you have a very old
mouse

If you have an Apple mouse
that was manufactured before
2005, it’s possible that it truly
has only one button and can’t
be configured to allow a ‘right
click’.

If this is the case, I'd strongly

recommend purchasing a
mouse that has two buttons.

This book will always use the
terms ‘left click” and ‘right
click” to indicate which of the
mouse buttons you should use.

If you can’t attach a two-button
mouse, you can simulate a
‘right click’ by holding down
the <Ctrl> key before clicking
with the mouse.

Lesson 1-1: Configure your
mouse and understand right
clicking

If you're using your Mac with default settings and hardware, it’s likely
that your mouse appears to only have one button instead of two. This is
great for simple programs, but makes it more difficult to use complex
business applications like Excel.

It is possible to work with Excel using a single mouse button, but many
features are much easier to use if you're able to ‘right click’ to access a
contextual menu.

Even if your mouse only appears to have a single button, it’s likely that it
can be configured to recognize the difference between a ‘left click’ and
‘right click’. Only very old mice truly only have one button (see sidebar if
this is the case).

This lesson will show you how to enable two-button functionality on
your mouse.

1  Test your mouse.

Move your mouse pointer down to any of the icons on the Dock at
the bottom of the screen and click the right mouse button.

Even if your mouse only seems to have one button, click the mouse
with your finger on the right side of the mouse.

Remove from Dock

Show Launchpad

X1
If a contextual menu appears as shown above, your mouse is
already configured for right clicking and you don’t need to do

anything else. If no menu appears and a program opens instead,
read on to learn how to enable right-clicking.

2 Open the System Preferences dialog.

If it hasn’t been removed, you should see the System Preferences
icon on the Dock at the bottom of the screen:

If you don’t see this icon, you can access System Preferences by
going to the Launchpad by either clicking its icon on the Dock or
pressing the <F4> key.

Click the System Preferences icon.

The System Preferences dialog appears:

18
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trivia
The history of the
Apple mouse

The very first Apple mouse was
included with the Apple Lisa
system, released in 1983. The
Lisa mouse had only one
button, setting a standard that
Apple followed for over 22
years.

The design of Apple’s mice
remained very similar to the
Lisa Mouse until the Apple
Desktop Bus II mouse was
released in 1993. This was the
first of Apple’s mice to use the
rounded shape that is used by
almost every computer mouse
today.

The Apple Desktop Bus mouse
was followed by the Apple USB
Mouse in 1998. Nicknamed the
‘hockey puck’ because of its
round shape, the USB Mouse
was not very well received due
to its short cable and tendency
to rotate.

In the year 2000, the Apple Pro
Mouse was released. The Apple
Pro Mouse was Apple’s first
optical mouse, and the first to
use the ‘0-button” design that
has continued in Apple’s latest
generation.

The Apple Mighty Mouse was
released in 2005, and was the
first Apple mouse capable of
both left and right-click, as well
as including a trackball.

The most recent Apple mouse
as of 2016 is the Apple Magic
Mouse, first released in 2009.
The Magic Mouse replaces the
trackball with the ability to
perform gesture controls on the
surface of the mouse itself.

[ ] H System Preferences
— — @
" @ = | a o
General Desktop & Dock Mission Language Security Spotlight  Noftifications
Screen Saver Control & Region & Privacy
[ = O\
J  EE - (N
Displays Energy Keyboard Mouse Trackpad Printers & Sound
Saver Scanners

Open the Mouse settings dialog.

Click the Mouse icon in the System Preferences dialog (the 4t icon
from the left on the second row).

Mouse

The Mouse dialog appears:

Off d

Primary Button d Primary Button d
Off [
Serolling: | Vertical and Horizontal d

Note that this dialog may look different depending upon the type
of mouse you are using.

Set the right mouse button to Secondary Button.

1. Click the drop-down menu pointing to the right mouse button
and click Secondary Button from the shortcut menu.

Secondary Button d

2. Close the Mouse dialog by clicking the red Close button.
Test your mouse again.

Try right-clicking one of the Dock icons again. This time you
should find that the contextual menu appears.

© 2018 The Smart Method® Ltd
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Lesson 1-2: Start Excel and
open a new blank workbook

1 Move your mouse cursor to the bottom of the screen to
display the Dock if it's not already visible.

2 Click the Launchpad icon on the Dock.

*£.

All of your installed applications are displayed, including Microsoft
Excel.

Microsoft Word Microsoft PowerPaoint Microsoft Excel

3 Add the Microsoft Excel icon to your Dock.

You'll be using Excel a lot, so it makes sense to add it to the Dock.
This will make it appear at the bottom of the screen in future so
you'll be able to start Excel with just one click.

To add Excel to the Dock, point to the Microsoft Excel icon in the
list, then click and drag it down onto the Dock.

4 Click the Microsoft Excel icon to start Excel.

You can click the Microsoft Excel icon either from the Dock or from
the Launchpad screen.

Excel starts and is displayed on the screen:

Microsoft Excel

MS

Mike Task OR TTLE .
MAKE A LIST Total a List

o r om $139.00

s

Blank Workbook Make a List Total a List

20 https://TheSmartMethod.com
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After you’ve started Excel 2016

Microsoft Excel

TATK OR TILE
MAKE A4 LIST

oamw -~ ]

Blank Workbook Make a List

Total a List

ent

11
§1

]
oo

Cancel Create

Now that Excel 2016 has started, it needs to know whether you want to
create a new workbook, or whether you want to open a workbook that
was created earlier.

When creating a new workbook, Excel also offers to give you a “flying

nOte start” by using a template. Templates are sample workbooks that you can
. adapt and modify for your own needs. The idea is very good but, in

POtentlaI_ problems reality, templates are not usually a good choice as it can take longer to

when using templates adapt them to your true needs than to design from scratch (see sidebar).

Many of Microsoft’s templates In this lesson you'll create a blank workbook.

have been created using some

sy Azl ] ells Al 1  Create a new blank workbook.

teChmqueS; o el o o 1. Click the left mouse button on the Blank Workbook template.

them there’s a danger that you

may depend upon a workbook 2. Click the Create button in the bottom-right corner.

that you don’t understand and

are unable to maintain. Alternatively, you can double-click on the Blank Workbook

template.
Templates you create yourself P

are far more useful. Creating The Excel 2016 screen is displayed, showing a blank workbook:

your own custom templates is "

beyond the scope of this Basic ot O d G T  Workbook1 Q- ©-
Skills course but is covered in UG Insert  Pagelayout Formulas Data Review View &t Share ~
depth in the Essential Skills @ X . — _ oy . [E conditonal Formatiing v 1e=b1 .
book in this series (in: Lesson 3- K Sad= — A) B Q

& Format as Table v

14: Create a Template). Peste & Fomt  Allgnment  NUmber 5 el styles ~ e
Clipboard Styles
Al . fe v
A B C D E F G H
 — \

2 Leave the workbook open for the next lesson.

© 2018 The Smart Method® Ltd 21
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note

Office 365 and feature
updates

There are now two ways of
purchasing Excel 2016 — either
as a one-off purchase or as part
of a subscription service called
Office 365.

You will receive monthly
security and bugfix updates
regardless of how you
purchased Excel, but you will
only receive new features if you
have an Office 365 subscription.

The screenshots in this course
show the most up-to-date
version of Excel 2016 available
via Office 365, so some things
may appear differently if you
purchased a standalone retail

copy.

You can still work through this
course regardless of which
version you are using. Any
important differences will be
mentioned in sidebars like this
one.

Lesson 1-3: Check that your
Excel version is up to date

Updates

When a new product like Excel 2016 is first released it often has many
bugs (as do all computer programs of any size).

Microsoft is very pro-active at fixing bugs that are found and regularly
releases updates.

Updates normally only fix bugs found in the original program, but
Microsoft sometimes take things a little further by including new, or at
least enhanced, features with their updates.

I'had many emails from readers of my earlier Excel books suggesting that
some Excel features were missing, or that some of the examples didn’t
work. In almost every case the reader had switched automatic updates
off and was using an out-of-date Excel version.

Automatic Updates

Normally Microsoft Office (including Excel) will look after updates
without you having to do anything if Automatic Updates are enabled.

If you don’t enable Automatic Updates, there is a danger that you may
have an old, buggy, out of date version of Excel installed.

This lesson will show you how to enable Automatic Updates and make
sure that you are using the latest (most complete, and most reliable)
version of Excel 2016.

1 Start Excel and open a new blank workbook (if you have not
already done this).

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

2 Make sure that Automatic Updates are enabled.

1. If the Menu Bar isn't visible at the top of the screen, move the
mouse cursor to the top of the screen to make it appear.

You should see the following options:

@ Excel File Edit View

Insert Format Tools Data Window Help

If you see a different set of options, it means the Excel window
isn’t selected. Make sure that the Excel window is selected
either by clicking on it or by clicking the Microsoft Excel icon
on the Dock.

2. Click: #>Help->Check for Updates.
The Microsoft AutoUpdate dialog appears.

22
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note

The Office Insider
program

You might have noticed the
tempting option to Join the
Office Insider program in the
Microsoft AutoUpdate dialog.

Joining the Office Insider
program allows Microsoft to
install updates on your
computer that have not yet
been fully tested. This means
that you get early access to new
features, but it also greatly
increases the chances of
encountering bugs in the
untested early releases.

Microsoft offer two options for
Office Insider: Office Insider
Slow and Office Insider Fast.

The Slow option gives you early
access to new updates that have
already had some significant
testing but are not yet
considered ready for release.

The Fast option gives you
significantly earlier updates,
but with significantly more risk
of encountering bugs and
€rrors.

Joining the Office Insider
program is not a good idea for
most users. It is better to wait
for the final versions that have
been fully tested than to risk
the potentially disastrous
consequences of downloading
untested updates.

@

Microsoft AutoUpdate

AutoUpdate checks for update versions of your Microsoft software. For mare
information about AutoUpdate, see Help.

How would you like updates to be installed?

Manually Check
© Automatically Check
Automatically Download and Install

Join the Office Insider program to get early access to new releases
Choose how you get Insider builds Office Insider Slow

Office Insider Slow = Best for Insiders who want to get early access to fully
supported builds with minimal risk and provide feedback to make Office
great.

Learn more

eck for Updates |

3. Make sure that Automatically Check is selected.

Check for updates and update to the latest version if
necessary.

1. Click the Check for Updates button.

You may be prompted to enter your password to confirm that
updates should be allowed.

2. Install any updates that are available.

3. Click the red Close button =l in the top-left corner of the
Microsoft AutoUpdate window to close it.

Click the Close button =l in the top-left corner of the Excel
window to close Excel.

© 2018 The Smart Method® Ltd
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Lesson 1-4: Change the Office
Theme

Excel 2016 allows you to change the colors of screen elements (such as the
menu bar and ribbon) by selecting one of two themes. The available
themes are called Colorful, and Classic.

Colorful

° i S ¥ @& The. O~ ©-

Insert  Pagelayout Formulas Data Review View &FShare ~

ﬁ_ B % B — cy B f=| Conditional Formatting 14=b1 B B
'_r 1 = Twww — 0 =

& Format as Table ©

Paste Font Alignment Number ) Cells Editirg
& Cell Styles =

Al - fx Rank -
A B C D E

1 |Rank .Country GDP - per capita (PPP) Date of information

2 1 Qatar 5137,200 2014 est.

3 2 Luxembourg 597,600 2014 est.

4 3 Liechtenstein 589,400 2009 est.

5 4 Macau 588,700 2013 est.

Excel 2016 uses the Colorful theme as the default. The Colorful theme
makes it clear which of the Office applications you are using as Word,
Excel, PowerPoint, Outlook and other Office applications each have their
own unique color.

The previous version of Excel for the Mac (Excel 2011) didn’t provide the
option to change themes and was fixed to the Classic color scheme.

Classic
XK ] d G F [ The.. |Q- searchSheet © -
Home Insert Page Layout Formulas Data Review View &t Share
ey (}g —_— (y =] Conditicnal Formatting * 14—+l
. - = S = H- Q 5
'-r 3 - =Ese - 0 & Format as Table »
Paste " Font Alignment Number - Cells Editing
L5 & Cell Styles v
Al : fx Rank v
A B c D E
1 |Rank .Cﬂuntry GDP - per capita (PPP) Date of information
2 1 Qatar 5137,200 2014 est.
3 2 Luxembourg 597,600 2014 est.
4 3 Liechtenstein 589,400 2009 est.
5 4 Macau 588,700 2013 est.

The Classic theme doesn’t have the unique color scheme for each Office
application and instead uses the gray color scheme that was used by
Excel 2011 and earlier versions of Excel for the Mac.

1 Open Excel and open a new blank Excel workbook.
2  Change the Office Theme.
1. Click ®>Excel>Preferences.
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tip
You can also open the Excel

Preferences dialog by using the
<Cmd>+<,> keyboard shortcut.

note

Themes affect every
Office application

When you set a theme in Excel
you are actually changing the
theme for the entire Office 2016
application.

This means that you will have a
consistent experience when
using other Office applications
such as Word and PowerPoint.

3

. File Edit View

About Excel
Preferences... K =,
Sign Out...

Services >
Hide Excel #H

Hide Others “_¥H

Quit Excel ®Q

The Excel Preferences dialog appears.
Click General from the Authoring group.

Authoring
[k (=]
General View Ribbon &
Toolbar

The dialog changes to show the General options.

In the Personalize group, click the Office theme dropdown menu
and select Classic.

Personalize

User name: Microsoft Office User

Office theme « Colorful ]
Classic

Web Options...

A dialog pops up to inform you that this change will affect all
Office applications (see sidebar).

Theme choices apply to all Office apps

The theme you have selected will be applied to your
other installed Office apps the next time each one is
launched.

[ OK |

Click OK to close the dialog.
The color scheme changes immediately.

Experiment with each theme until you discover the one you
prefer. All of the screen grabs in this book were done using the
Colorful theme. If you choose the Classic theme, the screen
grabs in the book may look slightly different to what you see
on your computer screen.

Close Excel.

© 2018 The Smart Method® Ltd
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Lesson 1-5: Minimize, re-size,
move and close the Excel
window

The main Excel window has a dazzling array of buttons, switches and
other artifacts. By the end of this book they will all make sense to you
and you'll feel really comfortable with Excel.

For now, you'll explore the big picture by looking at how the Excel
window can be sized and moved. The details will come later.

1  Open Excel.

2 Use the Blank Workbook template to open a new blank
workbook.

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

3 Understand the Close, Minimize, and Zoom buttons

At the top left corner of the Excel window you can see three

buttons.
Close, Minimize and Zoom buttons
M d
Insert Page Layout Formulas Data >
ey — cy =] Conditienal Formatting ~ 14—k 1 (
I— =EL8 - & Format as Table * .— [
Clipboard Font Alignment Number Cells Et

& Cell Styles

Al - fx B

These are the Close, Minimize and Zoom buttons:

Don’t worry if they look like empty circles on your screen. The
icons will appear when you move your mouse close to them.

You’ll learn more about the Zoom button and Full Screen view in
the next lesson: Lesson 1-6: Understand Full Screen view.

4 Minimize and restore the Excel window
Try clicking the Minimize button.

Minimize reduces Excel to a button on right side of the Dock.

G

Click this button again to restore the window to its previous size.
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note

Other ways to close
Excel

There are two other ways of
closing an Excel window.

1. Click:
&—>File~>Close

2. Press the <Cmd>+<W>
keys on your keyboard.

note
Closing Vs Quitting

Excel doesn’t exit completely,
even if you close every open
Excel window. Instead, it stays
running in the background so it
can quickly reopen if it is
needed again.

This usually isn’t a problem,
but large numbers of open
programs can eventually cause
your computer to run slowly.

To completely close Excel, click:
&> Excel>Quit Excel

You can also do this by
pressing the <Cmd>+<Q> keys
on your keyboard or right-
clicking on the Excel icon on
the Dock and clicking Quit
from the shortcut menu.

You can also restore the Excel window by clicking the Excel icon
on the Dock (the same icon that you use to start Excel).

Re-size the Excel window.

Hover over either the side of the Excel window, or a corner of the
window, with your mouse cursor. The cursor shape changes to a
double-headed arrow.

+  100% =
LY

When you see either cursor shape, hold down the mouse button
and move the mouse (this is called click and drag) to re-size the
window.

Clicking and dragging a corner allows you to change both the
height and width of the window.

Clicking an edge allows you to change only one dimension.
Move the Excel window.

Click and drag the Title Bar (the bar at the very top of the window)
to move the Excel window around the screen.

Workbook1 L‘T

Formulas Data Review

Close Excel.

Click on the Close button [®] at the top left of the Excel window.
This is the most common way to close an Excel window.

There are also two lesser known (and lesser used) methods of
closing Excel windows (see sidebar).

Note that, on the Mac, closing all Excel windows is not the same as
quitting Excel (see sidebar for more on this).

© 2018 The Smart Method® Ltd
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Lesson 1-6: Understand Full

Screen view

You saw how to use the Minimize and Close buttons in the previous

lesson, but you haven't yet used the Zoom button.

The Zoom button allows you to enter Full Screen view, which dedicates
as much screen space as possible to the Excel window. You’'ll see how to

use the Zoom button in this lesson.

1  Open Excel.

2 Use the Blank Workbook template to open a new blank

workbook.

3 Enter Full Screen view.

Click the Zoom button to enter Full Screen view. @

The Excel window expands to fill the entire screen.

4 Access the Dock and Menu Bar while in Full Screen view.

The first thing you may notice is that the Menu Bar has
disappeared from the top of the screen and the Dock has
disappeared from the bottom. They have been hidden so that as
much screen space as possible can be dedicated to Excel, but they

can still be accessed.

1. Move the mouse cursor to the top of the screen.

hn® Excel File

View Insert

The Menu Bar appears, along with the Close, Minimize and

Zoom buttons.

2. Move the mouse cursor to the bottom of the screen.

g
40

F!ea-u-lg Z

k@

The Dock appears.

5 Exit Full Screen view.

1. Move the mouse cursor to the top of the screen to make the
Close, Minimize and Zoom buttons appear.

(@ o]
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tip
Alternative ways to

enter and exit Full
Screen view

As well as using the Zoom
button, there are a few other
ways to enter and exit Full
Screen view.

One alternative is to click:
&> View > Enter Full Screen

...or to exit full screen view:

&> View—>Exit Full Screen

You can also enter and exit full

screen view by using the
keyboard shortcut:
<Ctrl>+<Cmd>+<F>

...finally, you can also exit full

screen view by simply pressing

the <Esc> key.

note

If there is no Alt key
on your keyboard

Before 2006, Apple keyboards
used the Option key instead of
the Alt key.

If you don’t have an Alf key on

your keyboard, use the Option
key instead. It will work in
exactly the same way.

7

Notice that the Zoom button has a different appearance while
in Full Screen view.

2. Click the Zoom button once more to exit Full Screen view.
See sidebar for alternative ways to enter and exit Full Screen view.

Maximize the Excel window without entering Full Screen
view.

Full Screen view is useful when you need as much screen space as
possible, but it also makes it more difficult to access the Menu Bar
and Dock, and can interfere with Excel’s window management
features.

Windows in Full Screen view can’t be automatically rearranged by
Excel, as you'll see in: Lesson 2-2: Create a new workbook and view two
workbooks at the same time.

Fortunately, there’s a solution that enables you to maximize a
window without entering Full Screen view.

1. Move the mouse cursor to the Close, Minimize and Zoom
buttons so that their icons appear.

2. Hold down the <Alt> key (see sidebar if there is no <Alt> key
on your keyboard).

When you hold down the <Alt> key, the Zoom icon changes
into a + symbol.

3. Keeping <Alt> held down, click the Zoom button.

The window expands to fill the screen without entering Full
Screen view.

This method of maximizing the window doesn’t allow Excel to
fill as much screen space as Full Screen view, because it allows
the Dock and Menu Bar to remain visible.

Unless you have a very small screen, it’s usually better to
avoid Full Screen view. Keeping the Dock and Menu Bar
visible makes it easier to switch between programs and
windows, as well as providing more convenient access to
Excel’s own features.

Close Excel.

© 2018 The Smart Method® Ltd
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important

Organizing your
sample files folder

When you complete a lesson
that involves a sample file that
is changed, you will be
instructed to save the file with a
suffix.

By the time you've completed
the course you'll have sample
files such as:

Sales-1
Sales-2
Sales-3
Sales-4 ... etc

The first file is the sample file
that you downloaded and the
others (with the number suffix)
are interim versions as you
complete each lesson.

The sample file set includes the
starting sample file and all
interim versions.

The interim versions are
provided for three reasons:

1. If your work-in-progress
becomes unusable (for example
after a system crash) you can
continue without starting at the
beginning again.

2. If alesson doesn’t seem to
give the results described, you
can view the example to get
some clues about what has
gone wrong.

3. When you have completed
the course you will use this
book as a reference. The
interim versions allow you to
work through any of the
lessons in isolation if you need
to remind yourself how to use a
specific Excel feature.

It is a good idea to place the
sample files in a different folder
to your saved work. If you
don’t do this you'll be over-
writing the sample interim files
(such as Sales-1, Sales-2 etc)
with your own finished work.

’/The Wealth of Nations |

Lesson 1-7: Download the
sample files and open/navigate
a workbook

Excel uses the analogy of a book that has many pages. In Excel
terminology the term: Workbook is used for the entire book and Worksheet
for each of the pages. You'll be learning more about worksheets later in
this session in: Lesson 1-11: View, move, add, rename, delete and navigate
worksheet tabs.

1

4

Download the sample files (if you haven't already done so).

1. Open the Safari web browser and type in the URL:
http://TheSmartMethod.com

2. Click the Sample Files link at the top of the home page.

3. Download the sample files for:
Excel 2016 Essential Skills for Mac OS X.

Be sure to select the for Mac OS X version of the course, as the
Windows sample files may not work on a Mac.

Move the sample files to your Documents folder.

By default, the sample files will be downloaded to your Downloads
folder. They will be easier to access and work with if you move
them to your Documents folder.

1. Open Finder by clicking its icon on the Dock.

2. Click the Downloads folder under Favorites.
| 0 Downloads &k

3. Click and drag the downloaded AllSessions2016Essential file
into the Documents folder.

Open the sample workbook: The Wealth of Nations.
1. Open Excel.

2. Click Open on the left-hand menu bar.

3. Click: On my Mac in the central pane.

4. Navigate to your sample files, which should now be in the
Documents folder.

5. Open the AllSessions2016Essential folder.
6. Open the Session 1 folder.

7. Double click The Wealth of Nations to open the sample
workbook.

Go to Cell ZZ3 using the Name Box.
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Q-

View ©- ~

ng v 14=b1
- Q-

Cells Editing

Click here to move

one screen up

Click and drag this button
to quickly move up and
down the worksheet.

Click here to move
one screen down

l+‘

(&)

Mg ¥ g Q- -
Insert Page Layout Formulas Data > &+ Share A
F_ B — cy B [ Cpnditional Formatting ~ u;l i} C
L skl - 0 & Fdrmat as Table ~ >
Clipboagd Font Alignmdht Number . Cells Edit
& Cjll Styles v
B3 . fx | Luxembourg v
A C D
1 |Rank Country GDP - per capita (PPP) Date of information
2 1 Qatar 5137,200 2014 est.
3| 2fuuxembourg 1537,600 2014 est,
4 3 Liechtenstein 589,400 2009 est.
5 4 Macau SEB,700 2013 est.
4d p GDP Life Expectancy Maobile Phones +
Ready L] i ] - . + 100%

Excel uses the letter of the column and the number of the row to
identify cells. This is called the cell address. In the above example
the cell address of the active cell is B3.

In Excel 2016 there are a little over a million rows and a little over
sixteen thousand columns. You may wonder how it is possible to
name all of these columns with only 26 letters in the alphabet.

When Excel runs out of letters it starts using two: X,Y,Z and then
AA, AB, AC etc. But even two letters is not enough. When Excel
reaches column ZZ it starts using three letters: ZX, ZY, ZZ and
then AAA, AAB, AAC etc.

The currently selected cell is called the Active Cell and has a green
line around it. The Active Cell’s address is always displayed in the
Name Box and its contents are displayed in the Formula Bar.

You can also use the Name Box to move to a specific cell.

To see this in action, type ZZ3 into the Name Box and then press the
<Enter> key. You are teleported to cell ZZ3:

723 . fx v

Zz IT U W X Fag 1z ARA

2
3| Active Cell Formula Bar Active CeII—E!
4

Return to Cell A1 by pressing <Cmd>+<Home> (~).

Go to the end of the worksheet by pressing <Cmd>+<End>
(™).
Use the Scroll Bars.

There are two scroll bars for the Excel window, which appear
when you move the mouse cursor close to the edges of the screen.

The vertical scroll bar runs from top to bottom of the window and
allows you to quickly move up and down the worksheet.

The horizontal scroll bar is at the bottom of the window and allows
you to move to the left and right in wide worksheets. See sidebar
for how the scroll bars work.

© 2018 The Smart Method® Ltd
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note

You can also use the
<Cmd>+<S> keyboard shortcut
to save your work.

note

You can also use the
<Cmd>+<Shift>+<S> keyboard
shortcut to instantly display the
Save As dialog.

’/The Wealth of Nations |

Lesson 1-8: Save a workbook
to a local file

1

2

3

Open The Wealth of Nations from your sample files folder (if
it isn’t already open).

Save the workbook.

When you are editing a workbook, the changes you make are only
held in the computer’s memory. If there is a power cut or your
computer crashes, you will lose any work that has been done since
the last save.

For this reason, you should get into the habit of regularly saving
your work.

Even though you haven’t changed this workbook, save it by
clicking the Save button on the Quick Access Toolbar at the top left of
the screen.

Guilck Accags Toolhar

O d

Insert Page Layout

Save Button

Save the workbook with a different name.
1. Click: @=>File>Save As.

If you are signed into a OneDrive, the following dialog

appears:
Save As: | The Wealth Of Nations
(\I OneDrive - Persanal ] Documents »
|| Pictures >
Recent Folders
Public
>
Exercise 8
Documents
Mike Smart's OneDrive
Practice
+
On my Mac File Format: Excel Workbook (.xIsx) a
Options...
New Folder Cancel | (QEECICEE

Saving to a OneDrive enables you to store your files online (see
facing page sidebar).

2. If the OneDrive dialog appears, click the On my Mac button.

On my Mac
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note

OneDrive and Cloud
Computing
The Save As dialog allows you

to save your workbook to a
OneDrive:

& OneDrive

A OneDrive can be thought of
as a “disk drive in the sky”.

It is just like the Documents
folder on your computer but
exists on a Microsoft server
many miles away, accessed via
the Internet.

The OneDrive can be very
useful when you need to access
your files from several different
computers.

A OneDrive also provides an
easier way to share files with
others.

The OneDrive is part of a
completely new way of
working called Cloud
Computing.

Support for Cloud Computing
was first added in the Excel
2013 release.

Because Cloud Computing is
such an involved (and
complex) subject it is beyond
the scope of this Basic Skills
book.

The Essential Skills book in this

series devotes an entire session
to Cloud Computing (in Session
Eight: Cloud Computing).

Paste

«

Clipboard

This allows you to save the workbook to your own computer
instead of your OneDrive.

Click the drop-down arrow to the right of the File Format drop-
down list.

A list appears showing a large number of different file types:

SNt « Excel Workbook (xlsx)

Excel 97-2004 Workbook (.xls)

CSV UTF-8 (Comma delimited) {.csv)
Excel Template (.xItx)

Excel 97-2004 Template (.xt)

Web Page (.htm)

PDF

OpenDocument Spreadsheet (.ods)

Comma Separated Values (.csv)
Excel Binary Workbook (.xlsb)
Excel Macro-Enabled Workbook (.xlsm)

Ewvrnal Marra_Enahlad Tamnlata § wiEmil

v

Most of the time you’ll want to use the default format: Excel
Workbook but there may be times when you’ll need to save in
one of the other formats. You'll learn all about the most
important formats (and when you should use them) in the next
lesson: Lesson 1-9: Understand common file formats. For now,
you'll stay with the default: Excel Workbook format.

Click inside the Save As box.
Type: The Wealth of Nations Copy

Save As: | The Wealth Of Nations Copy{

Click the Save button.

Notice that the name of the workbook in the title bar (at the
top of the window) has now changed, indicating that you are
now viewing the new workbook that you have just saved.

D d & <

& The Wealth Of Nations Copy ~ .~ ©-

Formulas Data k ew \View &+ Share ~

% - n
& Fogffat as Table ~

Number Cells
& Fell Styles =

Insert Page Layout Developer

Font Alignment Editing

Styles
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v Excel Workbook (.xlsx)

Excel 97-2004 Workbook (.xls)

CSV UTF-8 (Comma delimited) {.csv)
Excel Template (.xltx)

Excel 97-2004 Template (.xlt)

Web Page (.htm)

PDF

OpenDocument Spreadsheet (.ods)

Comma Separated Values (.csv)

Excel Binary Workbook (.xIsb)

Excel Macro-Enabled Workbook (.xlsm)
Excel Macro-Enabled Template (.xltm)
Excel 2004 XML Spreadsheet (.xml)
Excel Add-in (.xlam)

Excel 97-2004 Add-in (.xla)

Single File Web Page (.mht)

UTF=16 Unicode Text (.txt)

Tab Delimited Text (.txt)

Windows Formatted Text (.txt)
MS-DOS Formatted Text (.txt)
Windows Comma Separated (.csv)
MS-DO0S Comma Separated (.csv)
Space Delimited Text {.prn)

Data Interchange Format (.dif)
Symbolic Link (.slk)

Excel 5.0/95 Workbook (.xls)

Lesson 1-9: Understand
common file formats

1 Open a new blank workbook.

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

2 View the file formats supported by Excel.
1. Click @->File>Save As.
2. Click the drop-down arrow to the right of the File Format list.

File Format: Excel Workbook (.xlsx) l-p

A list appears showing all of the different file formats
supported by Excel (see sidebar).

3 Understand the most important file formats.

Excel Workbook (the Open XML format)

Before Office 2007 was released, every Office program stored its
information on the hard disk in a completely different way. These
incompatible formats are called binary formats. This made it very difficult
to write applications that could be used together.

All of this has changed with the new file format that was first introduced
in Office 2007: Office Open XML.

Microsoft have published exactly how this format works and given it
away free to the world’s developer community. This allows other
programs to easily work with Excel workbook files. For example, Apple’s
iPhone supports Office Open XML Email attachments.

Unfortunately, the future has to co-exist with the past and there are still
some people in the world (though a rapidly declining number) using pre-
2007 versions of Office (97, 2000, 2002, 2003 and 2004). If you save your
files in the Open XML format, only people running Office
2007/2008/2010/2011/2013/2016 will be able to read them (but see the
sidebar on the facing page for two potential solutions to this problem).

Excel Macro-Enabled Workbook

An Excel Macro-Enabled Workbook is simply a workbook that has
program code (called VBA code) embedded within it. Macros are beyond
the scope of this book, but are covered in the Excel Expert Skills book in
this series.

While macro code is very powerful it can also be destructive, as it is
extremely simple to write damaging viruses within Excel macro code.

Macro programming (also called VBA programming) is a vast subject of
its own and is not useful to the vast majority of Excel users.
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note

How users of earlier
office versions can
read your Open XML
files

Microsoft has a free download:
Open XML File Format Converter
for Mac.

If users of Excel 2004 or earlier
install this, they will be able to
convert Open XML format
documents into the old 97-2004
workbook format.

Alternatively, you can choose
to save your files in the 97-2004
format if you need to allow
users of older versions to open
them.

note

Sharing files using
Cloud Computing
features

You should be aware that Excel
2016 provides another way to
share files with users that do
not have Excel 2016 (or, indeed,
any version of Excel) installed
upon their computer. This is
done using Excel 2016’s built in
Cloud Computing features.

Cloud computing also allows
users to open (and even edit)
Excel workbooks using devices
such as iPads, Android pads,
Windows PCs and
Smartphones.

Because Cloud Computing is
such an involved (and
complex) subject it is beyond
the scope of this Basic Skills
book.

The Essential Skills book in this

series devotes an entire session
to Cloud Computing (in Session
Eight: Cloud Computing).

Versions of Excel before Excel 2007 could potentially allow a workbook
to infect your machine with a macro virus because all Excel files were
capable of carrying macros. Because the formats are now separate, it is
easier to avoid opening potentially infected files.

Excel 97-2004 Workbook

This is the old binary format that allows users with earlier versions of
Excel to open your workbooks. Some features won’t work in earlier
versions and if you’ve used those in your workbook, Excel will display a
warning when you save telling you which features will be lost.

Excel Binary Workbook

An oddity in Excel 2007/2008/2010/2011/2013/2016 is a binary format
called: Excel Binary Workbook. This is a binary alternative to Open XML
but it can’t be read by earlier versions of Excel. The only advantage of
this format is that it loads and saves more quickly than Open XML. You
will only notice a speed difference when working with very large
worksheets.

PDF

If you need to send a worksheet to a user who does not own a copy of
Excel, you can save it in PDF (Portable Document Format). This format
was invented by Adobe and is also sometimes called Adobe Acrobat or
simply Acrobat.

All major web browsers can open and display PDF files. In Mac OS X,
PDF files will, by default, open using Preview. If you send a user a PDF
file you can be confident that they will be able to read and print (but not
change) the worksheet.

Other formats

As you can see, there are several other less commonly used formats
supported by Excel 2016, but the above formats are the only ones you’ll
normally encounter. The most important thing to remember is that,
unless there’s a good reason to use a different format, you should always
save documents in the default Excel Workbook format.

© 2018 The Smart Method® Ltd
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’/The Wealth of Nations |

Lesson 1-10: Pin a workbook
and understand file
organization

1 Close down and restart Excel.
2 Pin a workbook to the Recent Workbooks list.
1. Click Recent in the left-hand menu bar.

A list of recently opened documents appears in the right-hand
pane.

The list begins with the most recently opened workbook
(probably the Wealth of Nations Copy workbook saved in: Lesson
1-8: Save a workbook).

Today

The Wealth Of Mations Copy
B

The Wealth Of Nations
B

2. Hover the mouse cursor over one of the files in the Recent list:

The Wealth Of Mations

B3

Notice that a pin icon ] has appeared next to the workbook
name.

‘Pinning” a workbook can be a great time saver, as it enables
any workbook that you use a lot to always be shown in the
Recent Workbooks list. You won't have to waste time looking for
it on the hard drive.

You can also view all pinned documents by clicking the Pinned
button above the list of recent documents.

All

3. Click one of the pin icons. The item moves to the top of the list
and a pin icon appears next to it.

Today

f 3 The Wealth Of Nations »*

The Wealth Of Nations Copy
By

4. Double click on The Wealth of Nations to open the workbook.
3 Understand file organization.

By default, Excel saves all workbooks into your Documents folder
along with other Office documents (such as Word and PowerPoint
files). This clearly is going to cause problems when you have a few
hundred files.
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note

How do | create a
subfolder?

The concept of folders,
subfolders and files is a very
fundamental Mac OS X skill
rather than an Excel skill.

If you do not have basic OS X
skills (an understanding of how
OS X organizes files) you
would get good value from an
OS X book to give you the
foundation skills you need to
use any Mac program.

Here’s how you create a new
subfolder:

1. Use Finder to navigate to
your Documents folder.

2. Click: @>File>New Folder.

A new folder will appear called
untitled folder.

3. You will now be able to type:
Excel in order to name the
folder.

If this doesn’t work for you,
click the new folder and click:
&->File>Rename. You’ll then
be able to type: Excel to rename
the folder.

It is better to organize yourself from the start by setting up an

orderly filing system.

Create an Excel subfolder beneath your Documents folder.

I create a folder called Excel beneath the Documents folder. In this
folder I create subfolders to store my work. You can see a screen
grab of my Excel folder below (of course, your needs will be

different to mine).

¥ | | Excel

Accommodation
Accounts

Bank Reconciliations
Bank Statements
Book Publishing
Budgets

Business and employment
Cars and motorcycles
Credit Cards
Currency

Diet

Inflation Figures RPI RPIX
Insurance
Miscellaneous
Personal

Recipes

Stationery Orders
Taxes

Training

Travel

Tutorials

Yy ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ Y Y Yy vy vy v v vy yT yyewy

See sidebar if you don’t know how to create a subfolder.

© 2018 The Smart Method® Ltd
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note Lesson 1-11: View, move, add,
changingthe defaut rename, delete and navigate

number of

worksheets created in WO rkSheet ta bS

new workbooks

When you save an Excel file onto your hard disk, you are saving a single

When you open a new blank workbook containing one or more worksheets. You can add as many
workbook in Excel 2016, one worksheets as you need to a workbook.

new worksheet is automatically

created called Sheetl. There are two types of worksheet. Regular worksheets contain cells.

Chart sheets, as you would expect, each contain a single chart. If you

In some older versions of Excel . . . . . .
progress to the Essential Skills course in this series you'll exploring charts

(such as Excel 2010 for I
Windows), three worksheets in depth.
TR Gl Lol 1  Open The Wealth of Nations from your sample files folder (if

Sheet2 and Sheet3. sy
it isn’t already open).

My opinion is that this is a
change for the better, as it 2 Move between worksheets.
keeps things neater. Most of my
workbooks only need one
worksheet.

Look at the tabs in the bottom left corner of your screen. Notice
that this sample workbook contains three worksheets. Click on
each tab in turn to view each worksheet.

But if you long for the “good

Old days” here’s hOW you can | GDP Life Expectancy Mabile Phones +
make Excel 2016 mimic Excel
2010 (and earlier versions) at 3 Add a new worksheet.
tart-up: .
e 1. Click the New Sheet button (the plus sign next to Mobile Phones).
1. Click:
& Excel=> Preferences A new tab appears named Sheet1.
2. Click General. 2. Double-click the Sheet1 tab.
2. Enter the number of sheets 3. Type the word Population followed by the <Enter> key.
required in the Sheets in new
workbooks box: | GDP Population Life Expectancy Maobile Phanes + |
Sheets in new workbooks: 3 z 4 Move a worksheet’s tab.

1. Click on the Population tab (you may have to do this twice).

2. Hold the mouse button down and drag to the left or right. As
you drag, you'll notice an icon of a page and a black arrow
showing you where the tab will be placed.

3. Release the mouse button to move the tab to the location of
your choice.

-
GDP Population Life Expectancy |%‘1.’_1&}”&! Phones +

5 Understand the tab scroll buttons

Chick
Left one fab

| ponoss
b

| g
] Scroll to last tab
’/The Wealth of Nations Scroll to first tab
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note

Right clicking in Mac
oS X

Many of Excel’s features are
easier to access if you have two
mouse buttons.

You can see how to configure
your mouse to work this way
in: Lesson 1-1: Configure your
mouse and understand right
clicking.

To work through the course
with only one mouse button,
use <Ctrl>+Click whenever you
are instructed to right click.

tip
Alternative ways to
do the same thing

Excel often offers more than
one way to execute the same
command.

As well as using the right-click
menu, you can also delete a
workbook by using;:
&->Edit->Sheet>Delete Sheet.

Yet another way to delete a
worksheet is to use the ribbon
command:

Home—>Cells>Delete>
Delete Sheet

You can close a workbook
without using the menu bar by
using the <Cmd>+<W>
keyboard shortcut or the red
Close button.

10

Because this workbook only has four tabs, there’s no need to use
the tab scroll buttons (in fact, they don’t do anything when all tabs
are visible). When there are more tabs than will fit on the screen,
the tab scroll buttons are used to move between tabs.

Move between worksheets using the keyboard.

You can move between worksheets using only the keyboard by
pressing the <Cmd>+<PgUp> (#) and <Cmd>+<PgDn> (%)
keyboard shortcuts to cycle through all of the tabs in your
workbook.

Change tab colors.

1. Right click any of the worksheet tabs. A shortcut menu
appears.

If you don’t have a mouse with two buttons, <Ctrl>+Click will
have the same effect (see sidebar).

2. Move the mouse cursor to Tab Color and choose any color.

It is best practice to choose a color from the top block of Theme
Colors rather than one of the Standard Colors.

If you progress to the Essential Skills course in this series you'll
learn to use Themes and will then understand why the use of
theme colors is best practice.

3. Repeat for the other tabs on the worksheet.
Delete a worksheet.

Right click on the Population tab and select Delete from the shortcut
menu.

Delete several worksheets at the same time.
1. Hold down the <Cmd> key.

2. Click each tab you want to delete in turn. Don’t select them all
as it isn’t possible to delete every worksheet in a workbook.

3. Right click any of the selected tabs and select Delete from the
shortcut menu.

Don’t worry about the missing tabs. You're going to close the
workbook without saving it, so you won’t overwrite the original
workbook.

Close the workbook without saving it.
1. Click: #->File->Close.
A dialog is displayed:

2. Click Don’t Save so that you don’t over-write the workbook.

Do you want to save the changes made to the
document "The Wealth Of Nations.xlsx"?

Your changes will be lost if you don't save them.

Don't Save Cancel

Because you haven’t saved the workbook it will remain in its
original state when you next open it.

© 2018 The Smart Method® Ltd

39



Learn Excel 2016 for Mac OS X Essential Skills with The Smart Method

important

The ribbon shows
more if you have a
wider screen

When I work with Excel I use a
22-inch widescreen monitor
running at 1,600*900 pixels.

Excel uses all of the available
screen space to display
extended descriptions of each
feature on the ribbon.

For example, the Styles pane on
the Home ribbon shows six
buttons for ten common cell
styles, allowing them to be
applied with a single click
rather than two clicks.

Lesson 1-12: Use the ribbon

The ribbon provides fast access to hundreds of Excel features.

The sheer breadth of Excel features can seem overwhelming. This book
will gently introduce all of the most important features, one at a time.

By the end of the book you’ll be really comfortable and productive with
the ribbon.

1 Start Excel and open a new blank workbook.

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

2  Use ribbon tabs.

Each ribbon tab has its own toolkit available to you. By far the
most important tab is the Home tab which has buttons for all of the
most common and useful features.

Click each tab in turn and view the buttons. The screen grab below
has the Insert tab selected. Don’t worry if the buttons seem cryptic
at the moment. Most of them will make complete sense by the end
of this book (and if you later go on to complete the Expert Skills
course, Excel will have no mysteries left at all).

AL .

Insert Page Layout

& oW

Add-ins Recommended B L_'v |"|.-

- P
N

Tables lllustrations

RAibbon Ribbon Tabs Formula Bar

i ‘Workbook1

Formulas Data Review View

TS

Sparklines Slicer Link
Charts

e

3 Display ribbon group names.

The ribbon is divided into several groups of icons. Each group has
its own name, but these names are hidden by default. Displaying
the group names makes it much easier to find what you are
looking for.

1. Click: #>Excel>Preferences.
The Excel Preferences dialog appears.
2. Click View.
3. Inthe In Ribbon, Show group, click Group Titles.

In Ribbon, Show

Developer tab
Group Titles

4. Close the Excel Preferences dialog.

4 Type the word Test into any blank cell and then press the
<Enter> key on the keyboard once.

Notice how the Active Cell moves to the cell beneath.
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important

If your ribbon doesn’t
look like the
illustrations in this
book

Remember that the ribbon will
look different depending upon
the size of your screen (see
important sidebar on previous
page) but all of the features will
still be there.

Your ribbon may also look
different if you are using the
standalone retail copy of Excel
rather than the Office 365
version, as some new features
have been added to the Office
365 version.

1
2 Test

3 | 1]

A

5 Make the cell with the word Test into the active cell.

Click once on the word Test or use the arrow keys on the keyboard
to navigate back to the cell. Be very careful not to double-click,
otherwise Excel will think that you want to edit the cell.

A B
i

F I |Tes't .I

6 Click the Home tab on the ribbon and focus upon the Font

group (it's the second panel from the left). Try clicking each
of the buttons and you will see the word Test change to
reflect your choices.

This drop-down aliows you to This drop-down allows you
change the font {o something to change the size of the
different to the default Callbs. font (measured in poinds).
Calibri (Body) =+ 12 + A=~ A= These buiions sliow you to
change the cslls background
B I U- - %A - |anduedcur
Gld:hﬂmmtomd:oﬁm]
fext Bold, ltalie or Underlined
{or aW three). Click again to Clicking here puts a single
restors it to Normal. undoriine along the endlre
length of the botiom of the
This drop-down amow aliows cell. Try the drop-down armow
you to add 8 douile underiine. too for more border opélons.

7  Minimize the ribbon.

Click a second time on the Home ribbon tab.

Notice how the ribbon is now minimized in order to save screen
space (though the Formula Bar is still visible).

® i S

Home Insert Formulas

Page Layout
Al . fx

You can always minimize the ribbon by clicking a second time on
the currently selected tab.

8  Bring back the ribbon.

Click on any tab to bring back the ribbon.

9  Close Excel without saving changes.

1. Click: @->File>Close or click the red cross [®] in the top left
corner.

2. When asked if you want to save your changes, click the Don't
Save button.

© 2018 The Smart Method® Ltd
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General
Bl % | ) || %0
MNumber
B
4EN .
Insert
H "
u E R & i -
U Underline
D Double Underline

K ]
¢mm |, EEX .

EERN o

= Insert Cells...

[«] M

#= Insert Sheet Rows
§” Insert Sheet Columns

-« Insert Sheet

Lesson 1-13: Understand
Ribbon components

The whole is more than the sum of its parts.
Aristotle, Greek critic, philosopher, physicist & zoologist
(384 BC - 322 BC)

The ribbon is made up of several different controls.

Command group

Similar actions are grouped into a cluster. For example, every control
relating to numbers is clustered into the Number group.

Normal button

Simply executes a command when clicked. The Bold button on the Home
tab is a good example.

Menu button

This type of button has a little down-arrow on it. It will display a drop-
down menu when clicked.

Split button

This is the hardest button to understand because these buttons look
almost the same as the Menu button. When you hover the mouse cursor
over a split button, the icon and drop-down arrow highlight separately as
different “buttons within a button”.

A good example is the Underline button on the Home tab.

Clicking the icon part of a split button (the U) will perform the default
action of the button (in this case a single underline). Clicking the arrow
part of the button will display a drop-down list of further choices (in this
case the choice between a single and double underline).

Drop down list

I often shorten this to simply “Drop Down” in this book. A drop down is
a simple menu listing several choices.

If you see an ellipsis (...) after a drop down list item, this means that a
dialog will be displayed after you click, offering further choices.
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Gridlines Headings
v" View V’ Wiew

Print Print

Sheet Options

Drop down gallery

This is a little like a drop down list but has graphics to visually
demonstrate the effect of each choice.

[ [ | -

(K d | E L —
Ty 4EE, EEX. . A,
o | 8 1 H 3 ZY
Good, Bad and Neutral

Marmal Bad Good Meutra

Data and Model

| | 1 | exetanatory .. Mote

Check box

A little square box that you can click to switch an option on or off.

In this example (from the Page Layout ribbon) you are able to switch the

gridlines on and off for the screen display and/or the printout.

© 2018 The Smart Method® Ltd
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important Lesson 1-14: Customize the
Youmaynotbeable QuUick Access Toolbar and

to complete this

lesson if you are not preVieW the printout
using Excel 365

You can customize the Quick Access Toolbar to suit your own special

Customizing the Quick Access requirements. In this lesson, you'll add some useful buttons to the Quick
Toolbar is a feature that has Access Toolbar to save a few clicks when accessing common commands.
been added to Excel for Mac

since it was first released. The Quick Access Toolbar is one of the keys to being really productive with

Gty sl 240 s e Excel. This lesson will introduce you to the main features.

new feature updates, so you 1 Open The Wealth of Nations from your sample files folder.
will not be able to customize

the Quick Access Toolbar if you 2 Preview how the Life Expectancy worksheet will look when
are not using Excel 365. printed.

If you are using Excel 365 but 1. Click the Life Expectancy tab at the bottom of the worksheet.
still don’t see the options

shown in this lesson, it means 2. Click: File>Print.

you need to update to the latest

The Print dialog appears.

version.
You saw how to update Excel The Print dialog displays a huge number of print-related
in: Lesson 1-3: Check that your features. A preview of how the page will look when it is
Excel version is up to date. printed is displayed on the left-hand side of the dialog.

3. Click the Next Page and Previous Page buttons to move through
the print preview.

Notice there’s a button to the bottom-left of the preview pane
that allows you to cycle through each page:

: Nextand
‘“previous page
== buttons =

Tof 10 > b2

4. Click the Cancel button at the bottom right of the dialog to

Customize Quick return to the workbook.
Accoss Toolbar | 3 Add a Print button to the Quick Access Toolbar.
Button

Printing is a very useful feature and you'll probably use it a lot.
Every time you print, however, it is going to take two clicks of the
°c®e MEwW-OC ~ mouse. Wouldn't it be better if you could open the Print dialog
T with just one click?

1. Click the Customize Quick Access Toolbar button (see sidebar).
’/The Wealth of Nations 2. Click the Print item in the drop-down list.
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note

Not all Excel
commands can be
added to the Quick
Access Toolbar

Customizing the Quick Access
Toolbar is a relatively new
feature in Excel for Mac and
isn’t quite as comprehensive as
in Excel for Windows.

Many Excel commands cannot
yet be added to the Quick
Access Toolbar, but this can be
expected to change in the
future as Microsoft continue to
release updates.

tip
The Quick Access Toolbar is

one of the keys to being really
productive with Excel 2016.

Always try to minimize the
number of mouse clicks needed
to do common tasks.

If you find yourself forever
changing tabs to use a button,
change two clicks into one by
adding the button to the Quick
Access Toolbar.

All of those extra clicks add up
to a lot of time over the weeks
and years.

A new button now appears on the Quick Access Toolbar. You
are now able to Print your work with a single click of the
mouse.

® M E wvw-d&

m Insert Page Layout Formulas

4 Add a Copy button to the Quick Access Toolbar.

A More Commands... option is available when you click the
Customize Quick Access Toolbar button. This enables you to add any
of Excel’s commands to the toolbar.

1. Click the Customize Quick Access Toolbar button.
2. Click the More Commands... item in the dropdown list.

A dialog appears, showing all of Excel’s available commands
on the left and the commands on the Quick Access Toolbar on
the right.

3. Click Copy in the left-hand pane of the dialog.
4. Click the right arrow in the middle of the dialog.

Choose commands from:

Popular Commands E . .
Customize Quick Access Toolbar:
¥ Add or Remove Filters g | File
__ Borders |» k- save
~ Caleulate Now 2 Undo »
= Center Text (J Repeat
[ Conditional Formatting 3 I-‘_E‘_d Print

t:| Custom Sort...

5“ Cut

A~ Decrease Font Size S
= Delete Cells... k
! Delete Sheet Columns

== Delete Sheet Rows

5. Click Save.
A Copy button is added to the Quick Access Toolbar.

® ME wv-J = &

m Insert Page Layout Formulas

5 Remove the Copy button from the Quick Access Toolbar.

1. Click the Customize Quick Access Toolbar button and click More
Commands from the dropdown list.

2. Click Copy in the right-hand pane of the dialog and then click
the right arrow button in the middle of the dialog.

3. Click Save.

© 2018 The Smart Method® Ltd
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note

Page Break Preview
is only available in
Excel 365

The Page Break Preview feature
has been added to Excel for Mac
since it was first released.

New feature updates are only
provided to Excel 365 users, so
this option will not be available
if you are not using Excel 365.

If you are using Excel 365 and
still don’t have this feature, you
just need to update to the latest
version.

You saw how to update Excel
in: Lesson 1-3: Check that your
Excel version is up to date.

The Wealth of Nations

Lesson 1-15: Understand
views

Views provide different ways to look at your worksheet.

Excel 2016 has two main views. They are:-

View ‘ Icon

Normal

i

What it is used for

This is the view you’ve been using until
now. It's the view most users use all of the
time when they are working with Excel.

Page Layout

This view allows you to see (almost)
exactly what the printout will look like.

Unlike running a Print Preview, you are
able to edit cells just as you can in Normal
view.

Page Break

Preview ]

A page break indicates when the printer
should advance onto a new sheet of paper.

If you progress to the Essential Skills
course in this series, you'll use this view
in: Lesson 7 5: Insert, delete and preview page
breaks, to make sure that the page breaks in
the right place.

1 Open the Wealth of Nations sample workbook (if it isn’t

already open).

® O S =

- |

B The Wealth Of Nations Q.

Home Insert Page Layout Formulas Data Review View &t Share ~
C= — iti ing
J—‘ . <¥> . — . (y . E=| Conditional Formatting |:|| . Q B
! =l st - & Format as Table v
Paste = Font Alignment Number ) Cells Editing
<+ & Cell Styles =
Clipboard Styles
Al . fx  Rank v
A B c D E F G
1 |Rank JCountry GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
3 2 Luxembourg $97,600 2014 est.
4 3 Liechtenstein $89,400 2009 est.
5 4 Macau $88,700 2013 est.
] 5 Bermuda $85,700 2013 est.
7 6 Isle of Man $83,100 2007 est.
4 b GDP Life Expectancy Mobile Phones +
Ready 1T il [ — e—— 100%
View Buttons

You can change views in two ways:

1. By clicking one of the View buttons at the bottom of the
window (see above).
2. By clicking one of the buttons on the ribbon’s View tab (see

below).

B B

Mormal Page Break Page Custom
Preview  Layout Views

46

https://TheSmartMethod.com



Session One: Basic Skills

View the GDP worksheet in Page Layout view.
1. Click on the GDP tab.

2. Select Page Layout view by clicking:
View->Workbook Views->Page Layout.

ENEREE

Mormal Page Break Page Cusiom
Preview Layout Views

1 2 3 4
A B C
b § I Rank .Countr',l GDP - per capita (PPP)
1 Qatar 5137,200
3 2 Luxembourg 557 600

The worksheet is displayed in Page Layout view. You are able to see
(almost) exactly what will be printed. Headers, footers and
margins are all shown.

You are also able to edit the worksheet.

You may wonder why Excel users don’t use Page Layout view all of
the time when editing worksheets. While some users may prefer to
do this, most will want to see the maximum amount of data
possible on screen and so will prefer the Normal view.

3 Select Page Break Preview view.

Click: View>Workbook Views->Page Break Preview.
The worksheet is displayed in Page Break Preview view.

This view zooms out, showing the breaks between pages as blue
dotted lines:

A B C D
43 42 New Caledonia 538,800 :2012 est.
44 43 Greenland 538,400 :2053 est.
45 44 Japan 537,500 :2014 est,
46 45 andorra $37,200 12011 est.
a7 46 Equatorial Guinea 536,800 :2014 st
48| a7 vignslends | S%00 osest
49 48 Korea, South 535,400 :2014 est.
50 49 Mew Zealand $35,300 :2014 est.
51 50 Italy 535,100 : 2014 est.
52 51 Saint Pierre and Miguelon 534,900 :2056 est.
53 52 Spain 533,800 :2014 est.
54 53 Malta 533,200 12014 est.

It is possible to click and drag the dotted lines to change the place
where the page breaks.

This view is not covered in this Basic Skills book but is covered in
depth in the Essential Skills book in this series (Session Seven:
Printing Your Work).

4  Select Normal view.

Click: View>Workbook Views—>Normal.

© 2018 The Smart Method® Ltd
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Lesson 1-16: Hide and Show
the Formula Bar and ribbon

Most desktop computers have large display screens. The space taken by
the ribbon and Formula Bar isn’t usually a problem.

If you progress to the Essential Skills course in this series you'll discover
in: Session Eight: Cloud Computing that it is now possible to run Excel 2016
on tablet computers (and even on Smartphones). These devices often
have a very small display screen, meaning that the ribbon and Formula
Bar take up too much valuable screen space.

When screen space is limited, you may wish to hide the Formula Bar,
ribbon, or even both, in order to maximize the number of cells visible on
the screen.

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open) and click the Life Expectancy tab.

Notice that the Ribbon and Formula Bar are taking up space that
could be used to display the contents of the worksheet.

Consider the screen below:

M "o~ »

Home Insert rage Layout

Workbook
Views

Show @, Zoom to 100%

i Q. search Sheet

Formulzs Data »>

View Record

Macros Macro

The Wealth of Nations

Zoom Maeros

Al . fx Rank v
A B C D
1 |Rank .Cmmtr\I GDP - per capita (PPP) Date of information [}
2 1 Qatar 5137,200 2014 est.
3 2 Luxembourg $97,600 2014 est.
4 3 Liechtenstein 589,400 2005 est.
4 Macau 588,700 2013 est.
4 b GDP Life Expectancy Mobile Phones +
Ready LT m - D + 100%

This is the type of smaller screen that you might see on a small
tablet device or Smartphone.

Only five rows are visible, making the worksheet difficult to work
with. Hiding the Ribbon, Formula Bar, or both, will free up some
valuable screen space.

1 Hide the Formula Bar.
Click: View>Show—=>Formula Bar.

The Formula Bar vanishes:
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MAEwv- » B Q- ©-
Insert Page Layout Formulas Data > &t Share A
= - = E ()
- - z 100% A =
o | e O & &S
Waorkbook Show Q Zoom to 100% Window View Record
Views Macros Macro
Zoom Macros
A 8 c D
1 |Rank ACountry GDP - per capita [PPP) Date of information
2 1 Qatar 5137,200 2014 est.
4 p GDP Life Expectancy Mobile Phones +
Ready LT ] - — 100%

Reduce the ribbon display to only show tabs.

In: Lesson 1-12: Use the ribbon, you learned how to hide the ribbon

by clicking the selected ribbon tab a second time.

You can now see as much of the worksheet as possible, which can
be very useful on smaller screens.

0 6 = o e
Home Insert Pagelayout Formulas Data > &t Share
A B C o}
1 |Rank .countr-p GDP - per capita [PPP) Date of information
2 1 Oatar 5137,200 2014 est.
3 2 Luxembourg 597,600 2014 est.
4 3 Liechtenstein 589,400 2009 est.
5 4 Macau 588,700 2013 est.
B 5 Bermuda 585,700 2013 est.
7 & |sle of Man 583,100 2007 est.
B 7 Singapore 583,100 2014 est.
9 8 Brunei 579,900 2014 est.
10 9 Monaco 578,700 2013 est.
11 10 Kuwait 570,700 2014 est.
4 p GDP Life Expectancy Mobile Phones +
Ready 1T i ] - — 4 100%

3

Restore the ribbon and the Formula Bar.

1. Click any of the ribbon tabs.
The ribbon is restored.
2. Click: View—>Show—>Formula Bar.

The Formula Bar is restored.

M E v~ » Q- (
Insert Page Layout Formulas Data » &t Share ~
1™ . = f ()
. . Zoom 100% . . r _r
D - EI -
Workbook Show ﬁ Zoom to 100% Window View Record
Views Macros Macro
Zoom Macros
Al . fx  Rank v
A B C D
1 |Rank .cauntry GDP - per capita (PPP) Date of information
r] 1 Qatar 5137,200 2014 est.
3 2| Luxembourg 597,600 2014 est,
4 3 Liechtenstein 589,400 2009 est.
5 4 Macau SEB,700 2013 est.
4 GDP Life Expectancy Mobile Phones +
Ready 1T H N - — 4 100%
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note

The screen grabs
shown in this lesson
may differ from those
you see on your
screen

The Excel 2016 help system is
delivered online. This means
that Microsoft are able to
constantly correct and update
help topics.

For this reason, the information
you see on your screen may
differ from the screen grabs
shown in this lesson.

’/The Wealth of Nations |

Lesson 1-17: Use the help
search system

Excel 2016 for Mac not only provides information about Excel features,
but also enables you to execute ribbon commands directly from inside
the help system. This can be a huge time saver.

1

2

Open the Wealth of Nations from your sample files folder (if it
isn’t already open).

Click «>Help and click inside the Search box.

Search |

Excel Help
What's New

Check for Updates

When you click inside the Search box, a flashing cursor appears
and you are able to type a question.

Ask Excel how you can save a file.

You learned how to save a file in: Lesson 1-8: Save a workbook to a
local file. In that lesson you clicked the Save button on the Quick
Access Toolbar.

Imagine that you have forgotten how to save a file.

Type Save into the Search box.

Search Save Q

Excel displays a menu of choices, showing every command that
contains the word Save.

Search  Save [x]

Save

Save As...

Save as Template...
Restore > Restore to Last...
—1 Get External Data > Run S...

Help Topics B Get Help on Save —— Ramular onlina haln topics

Menu Items

Excel commands
({these can be execuied directly)

Notice that the list is delineated into two sections. The first section
contains commands. The second has the type of regular help
topics that you are used to reading in traditional help systems.

Execute the Save command directly from the search.

Click the Save command at the top of the menu:

In a traditional help system, you would have expected to see some
text explaining how the Save command works. Instead the
command is executed immediately. The workbook is saved in
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note

Some of the features
described in this
lesson may have
changed

As described in Lesson 1-3:
Check that your Excel version is
up to date, Microsoft regularly
release updates to Excel that
may add new features or
change existing ones.

If you are not using Excel 365
you may see Show All Help
Topics instead of Get Help on
Save and may notice that the
Restore command isn’t
available.

The help options still work in
exactly the same way, so you
should have no problems
working through this lesson.

note

You need an Internet
connection to use
Excel 2016’s help
features

In previous versions of Excel, it
was possible to access offline
help when no Internet
connection was available.

Support for offline help has
been dropped from Excel 2016.
If you have no Internet
connection, you will not be able
to access Excel’s help features.

exactly the same way it would have been if you had clicked the
Save button on the Quick Access Toolbar.

You can see that four other commands are also available:

e  Sgve As. You learned how to use the Save As command in:
Lesson 1-8: Save a workbook to a local file.

e Save As Template. Templates are not covered in this Basic
Skills book. The Essential Skills book in this series covers
the Templates feature in depth (in Session Three: Taking
Your Skills to the Next Level)

e Restore PRestore to Last Saved. This is the same as closing
without saving and then reopening to file.

o  Get External Data 2Run Saved Query. External data is
covered in the Expert Skills book in this series.

You can see how useful help search is when you can’t remember
where a command is situated on the ribbon and want to execute
the command as quickly as possible.

You can also see that it could be dangerous to execute commands
that you don’t understand.

Fortunately, Excel also offers regular help that you can read as a
reference.

Read the Excel help topics relating to the Save command.
Click: #>Help->Get Help on Save.

Search  Save o

Save

Save As...

Save as Template...
Restore > Restore to Last...
Get External Data > Run S...

Get Help on Save |,

Menu Items

Help Topics

Links to several topics from the Excel 2016 reference manual are
shown. You can click on any of these links to read Microsoft’s own
help topics about Save related features.

[ NON ] Excel Help
<l @4 ¢ & A A C, Save [x]

Save a file in Office for Mac
Save a Office file to a different file format, to a folder on your Mac,
or to an online service.

Automatically save and recover files in Office for Mac ...
Use AutoSave and AutoRecover to save or recover files
automatically in Office Word, PowerPoint, and Excel. You can set
several options for these features.

Save a workbook as a webpage
‘You can save a whole workbook or parts of a workbook to a web
page.

Change the file format for saving workbooks in Excel for ...
You can set Excel for Mac to save your workbooks in a variety of
different formats.

Note that you must be connected to the internet in order to view
the Excel help topics (see sidebar).

© 2018 The Smart Method® Ltd
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In this exercise you'll try to remember the name of each of the Excel screen elements. The answers are on the

next page so you might want to recap by turning the page for a little revision before you start.

Keep trying until you are able to name each of the screen elements from memory. You'll be seeing this

terminology during the remainder of the book, so it's important that you can correctly identify each element.

®- |

O d Workbook3
Insert Page Layout For nulas Data &t Share ~
_T—'\ . ¥ Calibri (Body) +|[12 o As A T T = General ~] | | Bl Gonattonsi Formatting ~ | ye=by, _ Q-
' - o = = = & Format as Table v
v A A4 A4 = + O .0 .00 2as
Paste < B I U i — = 9= | Fav = % I 00 .0  Cell Styles © Cells Editing
Clipboard Font Alignment MNumber Styles
c3 . fx -
B c D E F G 1 K L M N o
1 n
2 n
5 | —0Q 1
4 n
5 n
6 n
o f
8 n
9 n
10 | |
kil | |
12 | |
13 | |
14
15
16
17
18
19
20
21
22
23
24
25 1 1 1 1 1 1 1 1
4 » Sheet1 +
Ready lﬂ N [ - —— t 100%
Y | |
If you need help
slide the page to
the left
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Ribbon
Closo, Minimizo and Zoom butions
Quick Accoss Toclbar
Formula Bar

M d

Insert Page Layout

o =
1oy 3{) Calibri (Body) = 12 A= A~
i<

Paste Q‘f" B I U~ i -
Clipboard Font

fx

c3 .

[ —1—Active Cell

Name Box

(SRR T SR R

25 I I I I I
4 p| | Sheett | +

Ready 1

Title Bar

Workbook3
View

®- |

Review &t Share A~

Conditional Fermatting =
General v E = -

- & Format as Table ~
=" %

=e

b .0 .00

g0 #.0 Cells

Editing

¥

Inl

%
4

¢ Cell Styles +

Number Styles

100%

1
| o @ - — -

|
| Sheet Tab
Row Header

Tab Scroll butions
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Session Two: Doing Useful
Work with Excel

Only those who have the patience to do simple things perfectly ever
acquire the skill to do difficult things easily.

Unknown author

Now that you've mastered the basics, you are ready to do really useful
work with this amazing tool. In this session you will learn to use all of
Excel’s basic features properly. This will put you way ahead of anybody
that hasn’t been formally trained in Excel best practice. You'll be doing
simple things, but you'll be doing them perfectly!

Even after years of daily use, many users are unable to properly use
Excel’s fundamental features. They often reach their goal, but get there in
a very inefficient way, simply because they were never taught how to do
things correctly. By the end of this session you'll be astonished with how
well you are working with Excel.

Session Objectives

By the end of this session you will be able to:

Enter text and numbers into a worksheet

Create a new workbook and view two workbooks at the same time
Use AutoSum to quickly calculate totals

Select a range of cells and understand Smart Tags

Enter data into a range and copy data across a range

Select adjacent and non-adjacent rows and columns

Select non-contiguous cell ranges and view summary information
AutoSelect a range of cells

Re-size rows and columns

Use AutoSum to sum a non-contiguous range

Use AutoSum to quickly calculate averages

Create your own formulas

Create functions using Formula AutoComplete

Use AutoFill for text and numeric series

Use AutoFill to adjust formulas

Use AutoFill options

Speed up your AutoFills and create a custom fill series

Use the zoom control

Print out a worksheet
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Lesson 2-1: Enter text and
numbers into a worksheet

Excel beginners tend to reach for the mouse far too often. One of the keys
to productivity with Excel is to avoid using the mouse when entering
data. In this lesson you’ll quickly populate a worksheet without using the
mouse at all.

1

tip
Entering numbers as
text

Sometimes you need Excel to
recognize a number as text.

If you type an apostrophe (‘)
before the number, Excel won’t
display the apostrophe but will
format the cell as text. You’ll
notice that the number is then
left justified to reflect this.

When a number is formatted as
text you cannot perform any
mathematical calculations with
it.

First Quarter Sales and
Profit

Open the sample file: First Quarter Sales and Profit.

A B C D
Sales and Profit Report - First Quarter 2016

P

Jan Feb Mar
Mew York 22,000 253,000 1%,000
Los Angeles
Lendon
Paris

L= T = R ¥ (R T

Munich

Notice the difference between values and text.

Cells can contain values or text. Values can be numbers, dates or
formulas (more on formulas later).

Excel usually does a great job of recognizing when there are values
in a cell and when there is text. The giveaway is that text is always
(by default) left aligned in the cell and values are right aligned.

Look at the numbers on this worksheet. Notice how they are all
right aligned. This lets you know that Excel has correctly
recognized them as values and will happily perform mathematical
operations using them.

Save a value into a cell.

1. Type the value 42000 into cell B5. Notice that the mouse cursor
is still flashing in the cell.

42000

At this stage the value has not been saved into the cell.
If you change your mind, you can still undo the value by
pressing the <ESC> key at the top left of your keyboard or by

clicking the Cancel button Ll on the left hand side of the
Formula Bar.

2. Decide that you want to keep this value in the cell by either
pressing the <Enter>, <Tab> or an <Arrow> key on the

keyboard, or by clicking the Confirm button I:I on the left
hand side of the Formula Bar.

Enter a column of data without using the mouse.

When you enter data into a column, there’s no need to use the
mouse. Press the <Enter> key after each entry and the active cell
moves to the cell beneath. Try this now with the following January
sales data:
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important

The many ways of
entering numbers

Negative numbers

-123.56
(123.56)

Currency prefixes

Excel is quite happy for you to
prefix a number with a currency
symbol. The currency symbol it
will accept depends upon how
you defined the regional options
in OS X.

$123.56 (works in USA)
£123.56 (works in UK)

If you progress to the Essential
Skills course in this series you'll
learn an easy method of setting
$, £ and € currency prefixes
whatever your locale (in: Lesson
4-3: Format numbers using built-in
number formats).

Commas

12,234,567.78

Fractions

You must leave a space between
a number and a fraction for this
to work.

61/4
(six, space, one, /, four)

The above will appear on the
worksheet as 6.25 after you
enter it in this way.

01/4
(zero, space, one, /, four)

The above will appear on the
worksheet as 0.25. The leading
zero is needed to prevent Excel
from assuming that you are
entering a date.

Formula Bar

fx  lanuary
B C
fit Report - First Quarter 2016

| January .I Feb Mar

22,000 25,000

1. Type 18,000 into cell Bé.
2. Press the <Enter> key to move to cell B7.

3. Do the same to enter the following values into the next two
cells.

A B C D
Sales and Profit Report - First Quarter 2016

Pd et

3 Jan Feb Mar

4 Mew York 22,000 25,000 15,000
5 | Los Angeles 42,000

6 | London 18,000

7 | Paris 35,000

B |Munich 12,000

Enter a row of data without using the mouse.

You can also enter a row of data without using the mouse.
1. Clickin cell C5.

2. Type 39,000 and then press the <Tab> (-) key.

The <Tab> key is on the left hand side of the keyboard above
the <Caps Lock> key. Notice how pressing the <T'ab> key saves
the value into the cell and then moves one cell to the right.

3. Type 43,000 into cell D5 and press the <Enter> key.

You magically move to cell C6, as Excel assumes that you want
to begin entering data into the next row.

Complete the table without using the mouse.

By using the <Tab> or <Enter> key in the right place you should be
able to complete the table now without using the mouse:

A B c D
Sales and Profit Report - First Quarter 2016

[

3 Jan Feb ar

4 |New York 22,000 25,000 15,000
5 | Los Angeles 42,000 35,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
E | Munich 12,000 15,000 13,000

Change the text in cell B3 to January.

1. Double-click cell B3. Notice that there is now a flashing cursor
in the cell.

Jlan

2. Type uary on the keyboard to change Jan to January.
3. DPress the <Enter> key.
Change the text in cell B3 back to Jan using the formula bar.

Click once in cell B3 and then change the text in the formula bar
back to Jan (see sidebar).

Save your work as First Quarter Sales and Profit-2.

© 2018 The Smart Method® Ltd

59



Learn Excel 2016 for Mac OS X Essential Skills with The Smart Method

Lesson 2-2: Create a new
workbook and view two
workbooks at the same time

1 Open Excel and create a new blank workbook.

tl p 1. Close any open Excel windows and re-open Excel.

Other ways of 2. Double click the Blank Workbook template to create a new
creating a new workbook.

workbook Excel helpfully creates a workbook, unimaginatively named

Workbook1. If you already have a workbook open called
Workbook1, the new workbook will be called Workbook?2... and

e  Use the keyboard shortcut

<Cmd>+<N>.
SO on.
e  Click the File button on the
Quick Access Toolbar to Notice that Workbook1 is displayed on the Title Bar.
return to the Excel start
screen ™ | O + Workbookl Q-~ @~
’ Insert Page Layout . ormulas ELE] Review View &t Share ~
EB iy 3{) [s) f=| conditional Fermatting = (L]
- -r 1] - e A) & Format as Table * .— Q
. .. Paste @ Fent ignment Number Cells Editing
See more details of how this is < & Cell Styles ~
done in: Lesson 1-2: Start Excel CUSIEG S
a
and open a new blank workbook. Al v fx M
A B c D E F G H I
Y —
4 » Sheeti +
Ready LT i [ - . + 100%

2 Maximize the window without entering Full Screen view.

Hold the <Alt> key and click the green Zoom button at the top of
the Excel window to maximize the window without entering Full
Screen view.

[#]

It’s important that you are not in Full Screen view, as you cannot
view full screen windows side by side. You learned about Full
Screen view in: Lesson 1-6: Understand Full Screen view.

3 Create another new workbook and maximize it.
1. Click: @=>File>New Workbook.

2. A new blank workbook called Workbook? is displayed in the
workbook window.

3. <Alt>+Click the Zoom button to maximize the window.

You could be forgiven for thinking that nothing has happened
but you can see that the Title Bar now says: Workbook2,
showing that you are now looking at a different workbook.

Workbook2

Formulas Data Review

4 Use the Dock to move between workbooks.
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note

Finding a workbook
when many are open

As well as using the Dock, you
can also switch windows using
the Menu Bar and OS X's
Mission Control.

To switch windows with
Excel’s Menu Bar, click
&->Window. You'll then see a
list of all open workbooks and
can click to switch between
them.

To access Mission Control,
press the <F3> key on your
keyboard.

Mission Control allows you to
switch between all open
windows, not just Excel
windows.

Arrange Windows

Tiled

© Horizental
Vertical
Cascade

Windows of active workbook

Right click the Excel icon on the Dock at the bottom of the screen.

A shortcut menu is displayed, showing both Workbook1 and
Workbook2.

=1 Workbook1
v 1 Workbook?2

Try clicking Workbook1 and Workbook2 to switch between them.
Both workbooks are empty so you won’t see any difference in the
cells, but you should see the name changing in the Title Bar.

See sidebar for other methods of switching windows.
Display both Book? and BookZ2 at the same time.

In order to view two workbooks at the same time, they must not be
in Full Screen view. If either window is in Full Screen view, you
must exit this view using the skills you learned in: Lesson 1-6:
Understand Full Screen view.

1. Click: #>Window—>Arrange.
The Arrange Windows dialog is displayed.
2. Choose the Horizontal arrangement and click the OK button.

Both workbooks are now shown, one above the other. Each
window occupies exactly half of your screen:

i &J T Workbookl Q- ®-
Insert Page Layout Formulas Data N View &t Share ~
f\ . 3{} . — (y . E| Conditional Formatting ~ |:o| B Q .
| 1 - Ssae - o ¢ Format as Table ~ EmEE
Paste » Font Alignment Number . Cells Editing
L & Cell Styles =
Clipboard Styles
Al . fx v
A B (= D E F G H 1
) —
4 Sheet1 -+
Ready IT i [ - — + 100%

J = v

Insert Page Layout Formulas Data Review View &+ Share ~

L X — C'/ Conditional Fermatting = 141
- A = b~ - Q .

& Format as Table ~
o Cell Styles ~

Clipbeard Styles

4 » Sheet1 +

Ready 1T i [ = — + 100%

Notice that, as you click each workbook window, the Title Bar
and the Close/Minimize/Zoom buttons light up to show that this
is the active window.

Close Workbook2 and maximize Workbook1 to restore the
display to a single workbook.

If you’'ve forgotten how to do this, refer back to Lesson 1-5:
Minimize, re-size, move and close the Excel window and Lesson 1-6:
Understand Full Screen view.
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anecdote

I'ran an Excel course for a small
company in London a couple of
years ago.

The boss had sent his two office
staff to learn a little more about
Excel.

Before the course began I asked
the delegates how long they had
been using Excel. They told me
that they’d been using it for two
years to do all of their office
reports.

When I showed them AutoSum
they gasped in delight. “This
will save us hours” they told
me.

I'was curious how they had
been doing their reports before.

Believe it or not, they had been
adding up all of the figures in
each column with a calculator
and then manually typing the
totals at the bottom of each
column.

In this case the boss had given
them Excel as he had heard it
was very good. Unfortunately,
he had not initially seen the
need to train the staff in its use.

With no training it seemed quite
logical to them to use it like a
word processor and the boss
had still been delighted that his
staff were using such impressive
technology.

First Quarter Sales and
Profit-2

Lesson 2-3: Use AutoSum to
quickly calculate totals

Excel’s AutoSum feature is a really useful and fast way to add the values
in a range of cells together.

1 Open First Quarter Sales and Profit-2 from your sample files
folder.

2 In cell A9, type the word Total followed by the <Tab> key.

The active cell moves to the right and is now in cell B9:

A B C D
7 | Paris 35,000 26,000 31,000
E |Munich 12,000 15,000 13,000
9 ITI:rtaI
| |

3 Click: Home%Editing% (this is the AutoSum button).

AvtoSum
Button
|
E AutaSum v Ar“i)
3| Fill + z
a Sort &
&/ Clear » Filter
Editing

Something interesting has happened to the worksheet:

A B C D
1 | Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 Mew York 22,000 29,000 15,000
5 | Los Angeles 42,000 358,000 43,000
6 | London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
E | Munich 12,000 15,000 13,000
9 |rotal =SUM(B4:88)

Excel has placed a marquee around the number range that
AutoSum has guessed you want to work with. The pattern of dots
that marks the boundary of the marquee is called the marching ants.

The marching ants surround all of the numbers in the column
above, up to the first blank cell or text cell (in this case, up to the
word Jan).

=SUM(B4:B8) is your first glimpse of an Excel Formula. Formulas
always begin with an equals sign. This formula is using the SUM

function to compute the Sum (or total) of the values in cells B4 to

BS.

4 Press the <Enter> key to display the total January sales:
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tip
Entering an AutoSum

using only the
keyboard

You can also execute an
AutoSum using the keyboard
shortcut:

<Cmd>+<Shift>+<T>

7

A B C D

3 Jan Feb har

4 | New York 22,000 29,000 15,000
5 | Los Angeles 42,000 35,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
E | Munich 12,000 15,000 13,000
9 Total 129,000

Type the word Total into cell E3 and press the <Enter> key

once.

The active cell moves down one row and is now in cell E4.

A B C O E
3 Jan Feb Mar Total
4 I Mew York 22,000 25,000 15,000
5 | Los Angeles 42,000 35,000 43,000 1

Use AutoSum to calculate sales for New York.

1. Click: Home->Editing> AutoSum.

This time AutoSum correctly guesses that you want to sum the
values to the left of cell E4:

B C D E F
3 | Jan Feb Mar Total
a| 22,000 25,000 15,000 | =sum(B4ng |
5 42,000 353,000 43,000
2. Press the <Enter> key.
A B C D E
1 | Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 MNew York 22,000 29,000 15,000 70,000
5 | Los Angeles 42,000 35,000 43,000
6 | London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
E | Munich 12,000 15,000 13,000
3 Total 129,000

Save your work as First Quarter Sales and Profit-3.
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note

You can also delete
cell contents using the
mouse

Pressing the <Delete> key is the
fastest way to delete cell
contents.

You can also delete the contents
of a cell using the mouse. To do
this:

1. Right-click the cell.

2. Click Clear Contents from
the shortcut menu.

First Quarter Sales and

Profit-3

Lesson 2-4: Select a range of
cells and understand Smart
Tags

1

2

4

Open First Quarter Sales and Profit-3 from your sample files
folder (if it isn’t already open).

Observe the formula behind the value in cell B9.

Click once on cell B9 or move to it with the arrow keys on your
keyboard.

Look at the formula bar at the top of the screen. Notice that the cell
displays the value of a calculation and the formula bar shows the
formula used to calculate the value:

BS . fx =5UM(B4:B8)

A B C D
E | Munich 12,000 15,0 13,000
9 |rotal | 129,000 | 128,000
10
11 Value Formula

Delete the contents of cell BO.
Press the <Delete> key on your keyboard.

Change the word Total in cell A9 to USA Sales and press
the <Tab> key once.

The cursor moves to cell B9.

B | Munich 12,000
9 |L|5.-5. Sales

Select cells B4:B5 with your mouse.

When the mouse cursor is hovered over a selected cell, there are
three possible cursor shapes:

Cursor ‘ What it does

I ':II:II:' 16 .l The white cross (Select) cursor appears when

you hover over the center of the active cell.
You can then click and drag to select a range of
cells.

16 1 The black cross (AutoFill) cursor appears

4= | when you hover over the bottom right-hand
corner of the active cell. You'll be covering
AutoFill later in this session.

_‘.lEI The hand (Move) cursor appears when you
—‘E"\-I?-—l hover over one of the edges of the cell (but not

the bottom right corner).
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note

Selecting cells with
the keyboard

To select cells with the keyboard
hold down the <Shift> key and
then use the <Arrow> keys to
select the range needed.

note

Selecting a large
range of cells with the
<Shift>-click
technique

If you need to select a very large
range of cells it is sometimes
useful to use this technique:

1. Click the cell in the top left
corner of the required
range.

2. If necessary, use the scroll
bars to make the bottom
right corner of the required
range visible.

3. Hold down the <Shift> key.

4. Click in the bottom right
corner of the required
range.

ol 64,000 | 128,0
X

0 Formula Omits Adjacent Cells
Update Formula to Include Cells
Help on this Error
lgnore Error
Edit in Formula Bar
Error Checking Options...

Beginners often have difficulty selecting cells and end up moving
them or AutoFilling them by mistake.

Position the mouse at the center of cell B4 so that you see the white
cross (Select) cursor. When you see the white cross, hold down the
left mouse button and drag down to cell B5. You have now
selected cells B4 and B5 (in Excel terminology you’d say that you
have selected the range B4:B5).

A B
3 Jan
4 |MNew York 22,000 |
5 |Los Angeles 42,000 i

Display total USA sales in cell B9.

Because you have selected only the cells containing USA sales
(cells B4:B5), AutoSum can be used to show the value of the
selected cells.

Click the AutoSum button l=I to display the total value of the
selected cells.

USA sales are shown in cell B9.

r

3 | USASales 64,000 |

Notice the small green triangle at the top left of cell B9. This is
Excel’s way of saying: “I think you may have made a mistake”.

Inspect a potential error using a Smart Tag.

1. Click once on cell B9 to make it the active cell.
An Exclamation Mark icon appears III This is called a Smart
Tag.

2. Hover the mouse cursor over the Smart Tag.

A tip box pops up telling you what Excel thinks you may have
done wrong (see below). Of course, in this case, everything is
fine. The Smart Tag thinks that perhaps you didn’t want to
total just the USA sales — but the Smart Tag is mistaken!

UsA sale k 54.nunl 128,000

The formula in this cell refers to a range that
has additional numbers adjacent to it.

Examine the remedial actions suggested by the Smart Tag.

1. Hover the mouse cursor over the Smart Tag icon El
2. Click the drop-down arrow that appears.

A list of possible remedial actions is displayed. In this case you
can choose Ignore Error to remove the green triangle from the
corner of the cell.

Save your work as First Quarter Sales and Profit-4.
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Lesson 2-5: Enter data into a
range and copy data across a
range

Now that you have mastered the technique of selecting cells, you can use
it to speed up data entry.

When you select a range of cells prior to entering data, Excel knows that
all data entered belongs in that range. Several key combinations are then
available to greatly speed up data entry.

1
2

Open a new workbook and save it as Data Range Test.
Select cells B2:D4.

You learned how to do this in: Lesson 2-4: Select a range of cells and
understand Smart Tags.

A B C D E

N o W R

Type: London.

The text appears in cell B2, the top left cell in the range selected.
Press the <Enter> key.

The cursor moves to cell B3 as it normally would.

Type: Paris followed by the <Enter> key.

The cursor moves to cell B4 as it normally would.

Type: New York followed by the <Enter> key.

This time something new happens. The cursor doesn’t move to cell
B5 as you might expect, but jumps to cell C2 instead.

A B C D E

London
Paris
New York

o W

Type: 150,000 followed by the <Enter> key.

The value appears in cell C2 and Excel moves down the column
again to cell C3.

A B c D E
1
F i London 150,000
3 Paris
4 MNew York i
5
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note
Entering the % symbol

On most Mac keyboards, the %
symbol is entered by pressing:
<Shift>+<5>.

10

11

12
13

14

15

Press the <Enter> key without entering a value to leave C3
blank.

The cursor moves down the column to cell C4.
Type 225,000 followed by the <Enter> key.
The cursor jumps to cell D2.

Press <Shift>+<Enter> twice to change your mind about
leaving the value for Paris blank.

1. Press <Shift>+<Enter> to move backwards to the value for
New York.

2. Press <Shift>+<Enter> a second time and you are back to the

Paris cell.
A B C D E
1
F London 150,000
3 Paris
4 MNew York 225,000 :
5

Type 180,000 followed by the <Tab> key.

<Tab> moves you across the range, to cell D3.

A B C D E
1
2 Lendon 150,000
3 Paris 180,000
4 New York 225,000 5
5

You can now appreciate how to use the technique of <Enter>,
<Tab>, <Shift>+<Tab> and <Shift>+<Enter> to save a lot of time
when entering a whole table of data.

Select cells D2:D4.
Type 50% but don’t press the <Enter> or <Tab> keys.

The challenge this time is to place the same value into cells D3 and

D4 without having to type the value two more times.
Press <Cmd>+<Enter>.

The value is replicated into all of the other cells in the selected
range.

A B C D E
1
z London 150,000 50%
3 Paris 180,000 50%
4 Mew York 225,000 50‘%.
5

Click the Save button to save the Data Range Test
workbook.
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Lesson 2-6: Select adjacent
and non-adjacent rows and
columns

1
2
- 3
tip
Keyboard shortcuts
You can also make text bold by
using the keyboard shortcut:
<Cmd>+<B>
In the same way, you can make
text italic using the shortcut:
<Cmd>+<I>
...and underlined using the 4
shortcut:
<Cmd>+<U> 5
6

First Quarter Sales and
Profit-4

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Select all of column A.

Hover the mouse cursor over the letter A at the top of the column.
The column header lights up and the mouse cursor changes to a
black down arrow:

A} B C
1 |Sales and Profit Fepnr'l - First Quarter 2016

Click to select the entire column. The column becomes slightly
shaded and a green line surrounds all of the cells.

A B C D
1 |3ales and Profit feport - First Quarter 2016
i
3 Jan Feb flar
4 | Mew York 22,000 259,000 15,000

Click: Home—=>Font->Bold to bold face the column.

Because the whole column was selected, all of the values become
bold faced.

A B C D
1 |5ales and ProfitjReport - First Quarter 2016
2
3 Jan Feb har
4 |MNew York 22,000 25,000 15,000
5 |Los Angeles 42,000 35,000 43,000
6 |London 18,000 20,000 22,000

Click: Home—>Font->Bold once more to change the type in
column A back to normal.

Select all of row 4.

1. Hover the mouse cursor over the number on the left hand side
of row 4. The number button lights up and the mouse cursor
changes to a black arrow pointing across the row:

3 Jan
Smp Mewy York 22,000
5 | Los Angeles 42,000

2. Click to select the row.
Select columns B and C.

Hover the mouse cursor over the letter at the top of column B until
you see the black down arrow. When you see the arrow, click and
drag to the right to select columns B and C.
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A B | C ]
1 |Sales and Profit|Report - First Quarter 2016
F
3 Jan Feb Mar
4 | Mew York 22,000 29,000 15,000

Select rows 6 and 7.

1. Hover over the number at the left of row 6 until you see the
black arrow pointing across the row.

2. When you see the arrow, click and drag down to row 7 to
select both rows.

5 Los Angeles 42,000 33,000
B i Landan 18,000 20,000
7 | Paris 35,000 26,000

Select columns A, B, C, D and E without dragging the
mouse.

Sometimes you will need to select a large number of adjacent
columns or rows. You could drag across them, but it is often easier
to use the following technique:

1. Select column A.
2. Hold down the <Shift> key.
3. Select column E.

Columns A to E are selected.

oW R

A B C D E

Sales and Profit Report - First Quarter 2016

Jan Feb Mar Total
Mew York 22,000 29,000 19,004 70,000

Select rows 4 and 6.

Perhaps you need to perform an operation on two non-adjacent
rows. To select rows 4 and 6 you need to:

1. Select row 4.
2. Hold down the <Cmd> key on the keyboard.

3. Select row 6.

3 Jan Feb Mar

4 ] Mew York 22,000 29,000 19,000
5 | Los Angeles 42,000 39,000 43,000
& ] 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
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First Quarter Sales and
Profit-4

Lesson 2-7: Select non-
contiguous cell ranges and
view summary information

Non-contiguous is a very impressive word! It simply means a range of
cells that is split across two or more blocks of cells in different parts of the
worksheet.

Non-contiguous ranges can be selected using both the mouse and
keyboard. The keyboard method may seem a little involved at first but
you'll find it much faster once you have the hang of it.

1

2

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Select the contiguous range B4:D8 with the keyboard.

When you need to select a contiguous range with the keyboard
here’s how it’s done:

1. Use the arrow keys on the keyboard to navigate to cell B4.
2. Hold down the <Shift> key on the keyboard

3. Still holding the <Shift> key down, use the arrow keys on the
keyboard to navigate to cell D8

The contiguous range B4:D8 is selected.

A B C D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Fel Tlar Total
4 | Mew York 22,000 29,000 19,000 70,000
5 |Los Angeles 42,000 39,000 43,000
6 |London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000 5
3 USA Sales 64,000 128,000

Select the non-contiguous range B4:B8,D4:D8 using the
mouse.

1. Select the range B4:B8 using the mouse.

2. Hold down the <Cmd> key and select the range D4:D8 using
the mouse.

The non-contiguous range B4:B8,D4:D8 is selected:

A B C D E
1 Sales and Profit Report - First Quarter 2016
z
3 Jan Feb Miar Total
4 | New York 22,000 259,000 15,000 70,000
5 |Los Angeles 42,000 353,000 43,000
B |London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000
9 | USA Sales 64,000 128,000
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note
Where is the Fn key?

The Fn key may be in a different
place depending upon the
keyboard you are using.

On smaller keyboards, the Fn
button is usually in the lower
left corner, next to the Ctrl and
Cmd keys.

On larger keyboards, the Fn key
is on the right side of the
keyboard in the group of
buttons above the arrow keys.

note

If Fn+F8 doesn’t work

The F1-F12 keys at the top of
your keyboard are called
function keys. By default, these
are configured to perform
actions within OS X.

Holding the Fn key allows you
to override these actions and use
the standard functions of these
keys, enabling them to work
with the features of Excel and
other applications.

It’s possible to configure OS X to
allow these to work as standard
function keys by default. If this
is the case on your Mac, you can
just press F8 alone, without
holding Fn.

v Average

v Count
Numerical Count

v Minimum

v Maximum

v Sum

Select the same non-contiguous range with the keyboard.

This is a little more involved than using the simple
<Shift>+<Arrow keys> method used earlier.

Here’s how it’'s done:
1. Use the arrow keys on the keyboard to navigate to cell B4.
2. Press <Fn>+<F8> (F8 is on the very top row of your keyboard).

See sidebar if you can’t find the Fn key or if something
unexpected happens when you do this.

Use the arrow keys to navigate to cell BS.
Press <Fn>+<Shift>+<F8>.

Use the arrow keys to navigate to cell D4.
Press <Fn>+<F8>.

Use the arrow keys to navigate to cell D8.

® N & g bk W

Press <Fn>+<Shift>+<F8>.

The non-contiguous range B4:B8,D4:D8 is selected:

A B C D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Miar Total
4 | Mew York 22,000 29,000 70,000
5 |Los Angeles 42,000 35,000 43,000
6 |London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
B |Munich 12,000 15,000 13,000
9 | USA Sales 54,000 12E,000

Obtain total sales figures for January and March using the
status bar.

The status bar contains summary information for the currently
selected range.

Look at the bottom right of your screen. You can see the average
sales and total sales (sum of sales) for January and March:

Average: 25,700 Count: 10 Sum: 257,000

View the maximum and minimum sales for January and
March using the status bar.

Right-click the status bar and click Maximum and Minimum from
the pop-up menu (see sidebar).

The status bar now also displays maximum and minimum values.

Average: 25,700

Count: 10 Min: 12,000 Max: 43,000 Sum: 257,000

Close the workbook without saving.

© 2018 The Smart Method® Ltd
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Sales Report

Lesson 2-8: AutoSelect a
range of cells

When data is arranged in a block (as it is in the Sales Report used in this
lesson) it is referred to as a Range.

You will often want to select a row or column of cells within a range, or
even the entire range.

You can select ranges by using any of the techniques covered so far but
this could be very time consuming if the range encompassed hundreds,
or even thousands, of rows and columns.

In this lesson you'll learn how to select range rows, range columns and
entire ranges with a few clicks of the mouse.

1 Open Sales Report from your sample files folder.

This report contains a single block of cells in the range A3 to E19.

A B C D E
1 Weekly Sales Report
2
3 |Invoice No |Date Custormer Country  Total
4 10918 10 March 2016 | Bottom-Dollar Markets Canada 1,700.81
5 10917 10 March 2016 Romero y temille Spain 429.92
] 10926 10 March 2016 | Ana Trujillo Emparedados y helados | Mexico 60442
7 10929 11 March 2016 Frankenversand Germany | 1,380.33
B 10934 11 March 2016 | Lehmanns Marktstand Germany 587.50
9 10939 11 March 2016 | Magazzini Alimentari Riuniti Italy 749.05
10 10939 11 March 2016 | Magazzini Alimentari Riuniti Italy - 749.05
11 10925 12 March 2016 Hanari Carmes Brazil 558.29
12 10944 12 March 2016 Bottom-Dollar Markets Canada 1,204.75
13 10923 12 March 2016 | La maison d'Asie France B79.83
14 10937 13 March 2016 Cactus Comidas para llevar Argentina 737.64
15 10947 13 March 2016 | B's Beverages UK 258.50
16 10933 13 March 2016 Island Trading UK 1,081.71
17 10938 14 March 2016 QUICK-Stop Germany | 3,209.95
i8 10949 14 March 2016 Bottom-Dollar Markets Canada 5,195.85
19 10945 14 March 2016 | Morgenstern Gesundkost Germany 287.88
20 \
21 | This report excludes sales to Asia and South Africa. Range

2 Select all cells within the range to the right of cell A7.
1. Clickin cell A7 to make it the active cell.

2. Hover over the right hand border of cell A7 until you see the
hand cursor shape.

7 | 1051:521?;1 March 2016
8 10934 11 March 2016

3. When you see this cursor shape, hold down the <Shift> key
and double-click.

All cells to the right of A7, but within the range, are selected.

7 |

10829 11 March 2016 Frankenversand Germany 1,38D.33.|

3 Select all cells within the range except the header row.
1. Clickin cell A4 to make it the active cell.
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2. Hover over the right hand border of cell A4 until you see the

n Ote hand cursor shape.
Other ways to 4 [ 109180
AutoSelect a range = 10917 10

3. When you see this cursor shape, hold down the <Shift> key
and double-click.

Here’s how you would select All cells to the right of cell A4, but within the range, are

Using the keyboard

the entire range in the Weekly selected.

Sales Report (excluding the

header row) using the keyboard 4. Hover over the bottom border of the selected cells until you
method. see the hand cursor shape.

Make cell A4 the active cell by Date LS BIaT

HXVIgatmE Dt wiin e 10 March 2016 Bottom-Dellar Markets

<AITOW> KEYS. 10 March 2016 Romero y tomillo S

1. Press: <Cmd>+<Shift>+
<DownArrow>

Cells A4:A19 are selected.

5. When you see this cursor shape, hold down the <Shift> key
and double-click.

9 Press: <Cmd>+<Shifto+ The entire range (except the header row) is selected.

<RightAl‘l‘0W> A B C D E
The entire range (excluding 1 |Weekly Sales Report
the header row) is selected. 2
3 Invoice No Date Customer Country Total
Using shortcut keys 4 10918 10 March 2016 Bottom-Dellar Markets Canada | 1,700.81
5 10917 10 March 2016 Romero y tomillo Spain 429.92
The shortcut keys method is the ] 10926 10 March 2016 Ana Trujillo Emparedados y helados  Mexico 604,42
fastest way to select the entire 7 10929 11 March 2016 | Frankenversand Germany | 1,380.33
range including the header row. B 10934 11 March 2016 | Lehmanns Marktstand Germany 587.50
9 10939 11 March 2016 | Magazzini Alimentari Riuniti Italy 749.05
1.  Click anywhere inside the 10 10939 11 March 2016 Magazzini Alimentari Riuniti Italy . 749,05
range. 11 10925 12 March 2016 Hanari Carmes Brazil 558.29
2 Press: <Cmd>+<A> 12 10944 12 March 2016 | Bottom-Dollar Markets Canada 1,204.75
13 10923 12 March 2016 La maison d'Asie France E§79.83
The entire range (including 14 10937 13 March 2016 Cactus Comidas para llevar Argentina 737.64
the header row) is selected. 15 10947| 13 March 2016 | B's Beverages UK 258.50
i3 10933| 13 March 2016 | Island Trading UK 1,081.71
From the Menu Bar 17 10938| 14 March 2016 | QUICK-Stop Germany | 3,209.95
18 10949 14 March 2016 Bottom-Dallar Markets Canada 5,195.85
The Menu Bar method isn’t as 19 10945 14 March 2016 Morgenstern Gesundkost Germany 287 88
powerful as the other methods, 0
but does provide a way to select 21 | This report excludes sales to Asia and South Africa.

the current range (described as

S . You can also use this technique to select cells to the left of the
the region in the dialog).

active cell or above the active cell.
Make sure that the active cell is

within the range. 4 Close the workbook without saving.
1. Click:

&->Edit->Find>Go To...

The Go To dialog is

displayed.

2. Click Special...
The Go To Special dialog is
displayed.

3.  Click the Current Region
option button and then
click the OK button.
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note

Why are you calling
the pound sign a
hash?

In the USA and Canada, the
hash symbol is called the
pound sign or the number
sign.

In different USA/Canada
regions the single symbol has
different names because it can
be used to denote a number (as
in contestant #5) or as a weight
(as in 3# of butter).

Throughout this book I will
refer to the # as a hash because
that is the term used in most
other English speaking
countries.

note

Making several
columns or rows the
same size

Sometimes you will want to
make several columns exactly
the same width.

To do this, select the columns
that you want to resize and
then click and drag the
intersection of any of the
selected columns.

When the mouse button is
released, this will make each of
the selected columns exactly
the same width.

First Quarter Sales and
Profit-4

Lesson 2-9: Re-size rows and
columns

1

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Notice that columns B, C, D and E are far too wide for their
contents. It would be useful to make them narrower to keep the
worksheet compact.

Re-size column B so that it is just wide enough to contain the
January sales figures.

Hover over the line separating the letters B and C until you see the
re-size cursor shape:

B ..|.. C

When you see this shape, keep the mouse still and then click and
drag to the left. Column B will re-size as you drag. Make it
narrower so that the values just fit in the column. Notice that the
column width is displayed in points and pixels as you drag.

Y
L16 -
Y * Width: 9.83 (64 pixels) |

A B c O

Zales and Profit Report - First Quarter 2016

Pud

Jan Feb Mar
MNew York 22,000 29,000 15,000

- Y

Re-size column B so that it is too narrow to contain the
January sales figures.

Notice that when the column isn’t wide enough to contain the
contents, hash signs are shown instead of values (if you're used to
hashes being called pound signs or number signs see the sidebar).

A B C o

Sales and Profit Report - First Quarter 2016

[

Jan Feb Mar
HEERLE 29,000 15,000

3
4 | Mew York

Automatically re-size column B so that it is a perfect fit for
the widest cell in the column.

1. Hover over the line separating the letters B and C until you see
the re-size cursor shape:

B + C

2. When you see this shape, double-click to automatically re-size
column B.

Automatically re-size every column in the worksheet in one
operation.
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note

Other ways to re-size
rows and columns

You can also re-size rows and
columns using the ribbon.

Click: Home—>Cells>Format.

A drop-down menu appears.

1= 1 B E AutoSum - A#
I Row Height...
AutoFit Row Height

= Column Width...
AutoFit Column Width
Default Width...

You can use the Row Height and
Column Width options to set the
row or column to a specific
number of centimeters or
inches (depending on your
Excel settings).

You can also use the AutoFit
Row Height and AutoFit Column
Width options to automatically
size the row or column (you
achieved this more efficiently
with a double-click in the
lesson).

Default Width... allows you to
set a new width for all columns,
but this will not affect columns
that have already been
manually resized.

You can also resize rows and
columns using the following
Menu Bar commands:

&->Format->Row—>Height
&->Format—> Column—->Width

7

1. Select every cell in the worksheet by clicking the select all
button in the top left corner of the worksheet (you can also do
this by clicking in any blank cell and then pressing
<Cmd>+<A>).

u A
1 | sales and Profit

2. Hover over the intersection of any two columns until you see
the re-size cursor shape and then double-click.
Every column is now perfectly sized.

Notice that AutoFit has done its job rather too well. Column A
is now wide enough to accommodate all of the text in cell Al.

A B
1 |Sales and Profit Report - First Quarter 2016

Automatically re-size column A so that it is only wide enough
to contain the longest city name (Los Angeles).

1. Select cells A4:A9.
2. Click: Home—>Cells>Format—-> AutoFit Column Width.

This time the column is automatically sized so that it is wide
enough to contain all of the text in the selected cells.

A B C D E
1 Sales and Profit Report - First Quarter 2016
z
3 Jan Feb nar Total
4 Mew York 22,000 29,000 15,000 | 70,000
5 |Los Angeles 42,000 39,000 43,000

Notice that the text has spilled over from cell Al into the adjoining
columns B, C, D and E. This always happens when a cell contains
text and the adjacent cells are empty.

Manually size row 3 so that it is about twice as tall as the
other rows.

Do this in exactly the same way as you re-sized the columns but,
this time, hover between the intersection of rows 3 and 4 until you
see the re-size cursor shape, and then click and drag downwards.

1 |Sales and Profit Report - First Quarter 2016
2 Height: 15.00 (15 pixels)
R [Tan TFeb Mar

& New York 22,000 | 29,000 15,000

Auto-resize row 3 so that it is the same size as the other
rows again.

1. Hover over the line separating the numbers 3 and 4 until you
-
see the re-size cursor shape. %7

2. When you see this shape, double-click to automatically re-size
row 3.

Close Excel without saving.

© 2018 The Smart Method® Ltd
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First Quarter Sales and
Profit-4

Lesson 2-10: Use AutoSum to
sum a non-contiguous range

In: Lesson 2-7: Select non-contiguous cell ranges and view summary
information, you learned how to view the sum of January and March sales
using the status bar. But how can you put that value onto the worksheet?

Now that you have the hang of selecting non-contiguous ranges, you can
use this skill in conjunction with your AutoSum skills to create a formula
that will calculate the total of a non-contiguous range.

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2 Enter the text Jan/Mar Sales in cell A10 and press the

<Tab> key.

The active cell moves to cell B10.

3 Re-size column A so that it is wide enough to contain the

text.

1. Hover over the line separating the letters A and B until you see

the re-size cursor shape:

A+ B

2. When you see this shape, keep the mouse still and then click
and drag to the right. Column A will re-size as you drag. Make
it wider so that the words Jan/Mar Sales comfortably fit in the

column:

A

Maw York

Los Angeles
London

Paris

Munich

USA Sales

10 I_Ia n/Mar Sales

[ = S = IR I = TR - F

Jan
22,000
42,000
18,000
35,000
12,000
54,000

*
L

Sales and Profit Report - First Quarter 2016

Feb
259,000
359,000
20,000
26,000
15,000

D

hdar
153,000
43,000
22,000
31,000
13,000

4 Use AutoSum to calculate the total sales for January and

March in cell B10.

1. Click Home%Editing% (the AutoSum button).

An AutoSum appears in cell B10, but it isn’t anything like what
you want yet. AutoSum guesses that you want to sum all of
the values above, including the USA Sales total.

B |Munich

9 | USA Sales

10 |.Ian.-rl'v13r Sales
11

12,000 | 15,000
54,000
=5UM{E4:88)

13,000
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2. Select the range B4:B8 with the mouse.

3. Hold down the <Cmd> key and select the range D4:D8 with

the mouse.

Notice that the non-contiguous range B4:B8,D4:D8 is shown in
the AutoSum’s formula:

1
2
3
4
5
]
7
B
9

11

A B

C

D

Sales and Profit Report - First Quarter 2016

Jan
[ ] [ ]
Mew York 22,000
Los Angeles 42,000
Londan 18,000
Paris 35,000
Munich 12,000 .

L
USA Sales 64,000

10 I.lan.-‘l'v'lar Sales | =5UM({E4 '53,D-1:3':T-1

Fekb i flar . Total
25,000 15,000 | 70,000
35,000 43,000

20,000 22,000

26,000 31,000

15,000 . 13,000 .

4. Press the <Enter> key to show the sales for January and March

in cell B10.
A B C D E

1 |Sales and Profit Report - First Quarter 2016

2

3 Jan Feb Mar Total
4 Mew York 22,000 25,000 15,000 70,000
5 | Los Angeles 42,000 33000 43,000

6 | London 18000 20,000 22,000

7 | Paris 35,000 26,000 31,000

E | Munich 12,000 15000 13,000

9 |USA Sales 64,000
10 Jan/tar Sales | 257,000
11

5 Save your work as First Quarter Sales and Profit-5.

© 2018 The Smart Method® Ltd
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Z AutoSum | T

2, Sum

Average

EA‘G?T

Count Numbers
Max
Min

More Functions...

First Quarter Sales and
Profit-5

Lesson 2-11: Use AutoSum to
quickly calculate averages

Excel’s AutoSum feature isn’t only restricted to addition. It is also able to
compute averages and maximum/minimum values.

In this lesson you'll use AutoSum to calculate the average sales for each
month.

1

2

Open First Quarter Sales and Profit-5 from your sample files
folder (if it isn’t already open).

Delete cells E3:E4.

Select cells E3 and E4 and press the <Delete> key on your
keyboard.

Type the word Average in cell E3 and press the <Enter>
key.

The cursor moves to cell E4:

A B C o E

3 Jan Feb Mar Average
4 INE'.'-' York 22,000 25,000 15,000 | I

Use AutoSum to create a formula that will show the average
New York sales in cell E4.

1. Click: Home->Editing=> AutoSum->Drop down arrow
(see sidebar).

A drop down menu is displayed, showing all of the different
ways in which AutoSum can operate upon a range of cells.

2. Click Average.

3. Excel generates an AVERAGE function and inserts the cell
range B4:D4. This is exactly what you want:

E F

i Average
L=AVEHAGE['}-1 D4y

4. Press the <Enter> key to see the average sales for New York:

3 Jan Feb har Average
4 | New York 22,000 | 25,000 15,000 23,333

Type the word: Maximum into cell F3 and then press the
<Enter> key.

Use AutoSum to create a formula in cell F4 that will show the
Maximum New York sales for this period.

1. Place an AutoSum in cell F4, but this time choose Max from the
drop-down menu.

This time you have a small problem. AutoSum is including the
average value (23,333) in the calculation.
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tip
Another way to bring back the
blue box showing a range is to

click the range in the Formula
Bar.

B C D E F
Jan Feb har Average | Maximum

[ ] C
I. 22,000 | 25,000 15,000 23,333 | =MAX[B4:E)

2. Select cells B4:D4 with the mouse

The marquee now covers the correct cells and the average
value in cell E4 is no longer included.

3 ..Ian Feb hiar .Auerage Maximum
4 INEWYurk I. 22,000 | 29,000 15.0&31 23,333 |=MAX|[B4:04

Notice that the MAX function is now working with the range
B4:D4.

3. Press the <Enter> key to see the maximum sales the New York
office managed during the first quarter of the year:

3 Jan Feb har Average  Maximum
4 | Mew York 22,000 25,000 15,000 23,333 25,000

7 Change the words USA Sales in cell A9 back to Sales and

press the <Tab> key.

8 Press the <Fn>+<F2> keys on the keyboard (or double-click

cell B9) to bring back the marquee (shown as a blue box).

9 Adjust the marquee using click and drag so that all offices

are included in the Sales total.

Notice that there is a small blue square on each corner of the range.

These are called sizing handles.

1. Hover the mouse cursor over the bottom right (or bottom left)
sizing handle until the cursor shape changes to a double
headed arrow. It is really important that you see the double
headed arrow and not the hand or white cross.

2. When you see the double headed arrow, click and drag with
the mouse down to cell B8.

3. Release the mouse button.

4. Press the <Enter> key.

A B

3 Jan

4 | New York 22,000
5 Los Angeles 42,000
6 | London 18,000
7 | Paris 35,000
B | Munich 12,000
0 | Sales 129,000
10 | JanfMar Sales 257,000

10 Save your work as First Quarter Sales and Profit-6.

© 2018 The Smart Method® Ltd
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important

Formulas automatically
recalculate whenever any of the
cells in the formula change.

For example: If you were to
change the Paris sales to 45,000
this would cause cell B9 to re-
calculate to 139,000.

Because B9 has changed this
would, in turn, cause the profit
to recalculate to 56,000.

First Quarter Sales and
Profit-6

Lesson 2-12: Create your own
formulas

The AutoSum tool is very useful for quickly inserting SUM(),
AVERAGE(), COUNT(), MAX() and MIN() formulas into cells. Many
Excel users never get any further with their formulas than this.

In this session you'll create your own formulas without the use of
AutoSum. You'll be amazed at how easy it is.

1

2

Open First Quarter Sales and Profit-6 from your sample files
folder (if it isn’t already open).

Select cells A10:B10 and press the <Delete> key once.
The previous contents of cells A10:B10 are removed.
Type the word Costs into cell A11 and Profit into cell A12.

Type the value 83,000 into cell B11 and press the <Enter>
key to move down to cell B12.

11 Costs B3,000
12 | Profit

Enter a formula into cell B12 to compute the profit made in
January.

1. Type: =B9-B11 into cell B12.
2. Press the <Enter> key.
The profit for January is displayed:

9 Sales 129,000
10

11 Costs B3,000
12 |Profit 45,000

Enter the formula again using the mouse to select cell
references.

The method that you have just used to enter the formula works
just fine but it isn’t the best method. Sooner or later you will make
a mistake. For example, you could easily type =B8-B11, resulting in
an incorrect answer.

To eliminate such errors, you should always select cell references
visually rather than simply typing them in. You can visually select
cells using either the mouse or the keyboard. First you'll use the
mouse method.

1. Clickin cell B12 and press the <Delete> key on the keyboard to
clear the old formula.

Press the equals <=> key on the keyboard.
Click once on the value 129,000 in cell B9.
Press the minus <-> key on the keyboard.

Click once on the value 83,000 in cell B11.

A e

Press the <Enter> key on the keyboard.
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+

¥

important

Addition
Subtraction
Multiplication
Division
Percent

Exponentiation

The Excel Operators

Name Example

1+2
7-5
6*3
15/5
25%
472

10

If you followed the above steps carefully you will see that you
have created the same formula but with a much lower possibility
of making a mistake.

Enter the formula again using the visual keyboard technique.

The very best Excel experts hardly use the mouse. You waste
valuable seconds every time you reach for the mouse.

Here’s the expert technique of visual selection via keyboard:

1. Use the arrow keys to navigate to cell B12 and then press the
<Delete> key on the keyboard to clear the old formula.

2. Press the <=> key on the keyboard.

3. Press the <Up Arrow> key three times to move to cell B9.
4. Press the <-> key on the keyboard.

5. Press the <Up Arrow> key once to move to cell B11.

6. Press the <Enter> key on the keyboard.

Type 10% Bonus into cell B13.

This employer is very generous and pays the staff ten percent of all
profits as an incentive bonus.

In cell A13 type the words: 10% Bonus and then press the <Tab>
key on the keyboard to move to cell B13.

Enter a formula that uses the multiplication operator.

The multiplication operator is not an X as you might expect but an
asterisk (*). The other Excel operators are shown in the sidebar.

You need to press <Shift>+<8> to enter an asterisk. If you are using
a full size keyboard with a numeric keypad at the right-hand side
you can also use the numeric keypad’s <*> key.

Whichever key you use you'll still see an asterisk in the formula.

Use either the mouse selection technique or the visual keyboard
technique to enter the formula shown below into cell B13 and then
press the <Enter> key to see how much bonus was earned:

=B12*0.1
A B
11 | Casts 83,000
| el |
12 | Profit 46,000
13 [10% Bonus  [=B12*0.1

Note that multiplying a value by 0.1 calculates ten percent of the
value. If you progress to the Essential Skills course in this series,
you'll learn more about calculating percentages in: Lesson 4-3:
Format numbers using built-in number formats.

11 Costs 3,000
12 | Profit 46,000
13 |10% Bonus 4,600

Save your work as First Quarter Sales and Profit-7.
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trivia

The feature that Excel uses to
help you out with function calls
first made an appearance in
Visual Basic 5 back in 1996 and
had the wonderful name:
IntelliSense. The Excel

implementation is called
Formula AutoComplete.

In 1996 I was working in
Switzerland (as a programmer
and analyst) developing a ski-
school management
application. I was extremely
impressed by how easy
IntelliSense made my job. I
didn’t have to remember
hundreds of function names
any more.

I was even slightly worried that
just about anybody could now
program (but, of course, I was
wrong).

Recently I was in London being
driven by a Hackney cab driver
(Hackney cab drivers know
every shortcut and back street
in London). He was worried
that Satellite Navigation would
now mean that anybody could
become a London cabbie.

Of course, he really had
nothing to worry about either!

note

Excel automatically
adds closing brackets
to functions

If you type:
=SUM(B4:B5

... and then press the <Enter>
key, Excel will automatically
add the closing bracket for you
resulting in:

=SUM(B4:B5)

First Quarter Sales and
Profit-7

Lesson 2-13: Create functions
using Formula AutoComplete

1

2

Open First Quarter Sales and Profit-7 from your sample files
folder (if it isn’t already open).

Type the words USA Sales into cell A15 and European
Sales into cell A16.

The text European Sales may have spilled over into column B if
column A isn’t wide enough to contain it.

If necessary, re-size column A so that it is wide enough for
the words European Sales to fit within the column.

You learned how to do this in: Lesson 2-9: Re-size rows and columns.

A
15 |USA Sales
16 |European Sales

Click into cell B15 and type =S into the cell.

Something amazing happens:

15 |usasales  [=s 1
16 |European Sales

17 SEARCH
= SEC

A list appears showing every function in the Excel function library
beginning with S. This feature is called Formula AutoComplete (if
AutoComplete didn’t display as expected see the facing-page
sidebar).

You've already encountered the SUM(), AVERAGE() and MAX()
functions courtesy of AutoSum.

You may be pleased (or dismayed) to know that there are over 300
functions in the Excel function library. The good news is that most
untrained Excel users only ever get to understand SUM() and
AVERAGE()!

When you typed =S Excel listed all functions beginning with S.
Continue typing: =SU

Notice that the list now only shows functions beginning with SU
and look... there’s the SUM() function that you need, three down
in the list.

You could simply click on it with the mouse, but let’s work like an
Excel pro and do it with the keyboard.

Press the <Down Arrow> key to move the cursor over the
SUM function.

Complete the formula to display the syntax box.
Complete the formula by pressing the <Tab> key.
Alternatively, type M( to finish the formula manually.



Session Two: Doing Useful Work with Excel

note

Enabling and
disabling
AutoComplete

As with so many other features,
Microsoft allows you to turn
this very useful feature off.

You’d never want to do this,
but you may work on a
machine that has had Formula
AutoComplete switched off
and you need to turn it on
again.

Click:
®->Excel>Preferences>
AutoComplete

...and make sure that the Use
AutoComplete box is checked.

note

The syntax box

The syntax box tells you which
arguments (sometimes called
parameters) the function needs.

SUM(number1, [numberz], ...)

The first argument has no
square brackets, meaning that
you can’t leave it out.

The second argument (shown
in square brackets) is optional.

The third argument is an
ellipsis (a row of three dots).
This means that you could
continue with more arguments
such as [number3], [number4]
etc.

For such a simple function as
SUM() the syntax box is hardly
needed, but later you'll
encounter functions that
require several arguments and
then the syntax box will be
invaluable.

15 IUS@I. Sales
16 |European 5ales
17

[=sumi l

SUM(number1, [numberz], ...)

Notice that a little box has appeared beneath the function. This box
displays the Syntax of the SUM function (see sidebar for more
information).

Select the cells that you need to sum (cells B4:B5) with the

mouse or keyboard.

If you want to be a real pro you should select them with the
keyboard. To do this:

1.
2.

Press the <Up Arrow> key repeatedly until you reach cell B4.

Hold down the <Shift> key and press the <Down Arrow> key
once to select cells B4:B5.

Press the <Enter> key.
The total USA sales are displayed in cell B15.

A B

¥ 54,000

15 | USA Sales

If you typed the formula in manually, you might notice that
Excel automatically added a closing bracket when you pressed
the <Enter> key (see sidebar facing page).

Use the same technique to create a SUM() function in cell

B16 to show the total European sales (cells B6:B8).

1.
2.
3.

Click in cell B16.
Type =SU

Press the <Down Arrow> key to move the cursor over the
SUM function.

Press the <Tab> key to automatically enter the SUM function
into cell B16.

Select the range B6:B8.
Press the <Enter> key.

B16 - fx  =SUM(B6:BS)
A B C D E
15 | USA Sales 64,000

16 IEuru pea i, 25 |Ir 63,000 .I
17

The formula should now be: =SUM(B6:B8)

10 Save your work as First Quarter Sales and Profit-8.
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note

If you don’t see the
AutoFill handle
somebody has
disabled AutoFill

It's almost certain that AutoFill
will be enabled on any
computer that you work on. It
is such a useful feature that you
wouldn’t want to disable it.

If you don’t see the AutoFill
handle (the black spot on the
bottom right hand corner of the
active cell) it’s because
somebody has switched
AutoFill off.

To bring it back, click:
&> Excel>Preferences> Edit

...and make sure that the Allow
fill handle and cell drag-and-drop
box is checked.

First Quarter Sales and
Profit-8

Lesson 2-14: Use AutoFill for
text and numeric series

1 Open First Quarter Sales and Profit-8 from your sample files
folder (if it isn’t already open).

2 Delete the text Feb and Mar from cells C3:D3.

Select cells C3:D3 and then press the <Delete> key on your
keyboard.

3 Make B3 the active cell

Click once inside cell B3. Notice that there is a green border around
the cell and a spot on the bottom right-hand corner. This is the
AutoFill handle. If you don't see it, refer to the sidebar.

Autofill
[ 1 Handle

4 Hover over the AutoFill handle with your mouse until the
cursor shape changes to a black cross.

Many of my students have great difficulty with this when they try
it for the first time.

e  You don't want the hand: @ — that would move the cell.

¢ You don’t want the white cross: El\::ﬂ:"J — that would select the
cell.

e  You want the black cross: ::'l::':' — the AutoFill cursor.

5 When the black cross cursor is visible, hold down the mouse
button and drag your mouse to the right to AutoFill the other
months: Feb and Mar.

Jan 1 =+
22,000 25000 -
42,000 | 35,000 L

Notice the tip that appears as you drag, previewing the month that
will appear in each cell.

When you release the mouse button, the name of each month
appears in cells C3 and D3.

B C D
3 I Jan Feb Mar

6 Type: Monday into cell A18 and AutoFill down to cell A24 to
show the days of the week.

(If you are not using an English language version of Excel you will
need to type Monday in your own language).
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10
11

12

13

14

15

In cell B18 type the number 1 and in cell B19 type the
number 2.

Select cells B18 and B19.

3]

AutoFill down to B24 to create sequential numbers:

A B

12 | Menday
19 | Tuesday
20 | Wednesday 3

In cell C18 type 9 and in cell C19 type 18.

Select cells C18 and C19.
g

_é,]:- 18 1

AutoFill down to B24 to create the nine times table.
A B C

18 | Monday 1 g

15 | Tuesday 2 18

20 | Wednesday 3 27

Use AutoFill to create sequential dates.

1. Type 01-Jan-16 into cell D18.

2. Type 02-Jan-16 into cell D19.

3. Select cells D18:D19.

4. AutoFill down to D24 to create sequential dates.
Use AutoFill to quickly copy text.

Sometimes you will want to duplicate the value from one cell into
many others to the right of, left of, beneath, or above the active cell.

When a cell containing text is the active cell and it isn’t defined as a
fill series (the built-in fill series are days of the week and months of
the year), AutoFill will simply duplicate the contents of the cell.

Type the text Adjusted into cell E18 and then AutoFill it down as
far as cell E24.

The same text is now shown in each of the cells:

A B C D E
18 | Monday 1 9 01-Jan-16 Adjusted
1% | Tuesday 2 18  02-lan-15 Adjusted
20 |Wednesday 3 27  03-lan-16 Adjusted
21 | Thursday 4 36 04-lan-16 Adjusted
22 | Friday 5 45  05-Jan-16 Adjusted
23 | Saturday & 54  06-lan-15 Adjusted
24 | Sunday 7 63 07-lan-16 Adjusted

Save your work as First Quarter Sales and Profit-9.
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First Quarter Sales and
Profit-9

Lesson 2-15: Use AutofFill to
adjust formulas

AutoFill can save you a lot of time when extending or copying text and
number sequences. But the story’s not over yet.

AutoFill’s ability to copy and adjust formulas is one of the most powerful
tools in Excel’s impressive toolbox.

1

2

Open First Quarter Sales and Profit-9 from your sample files
folder (If it isn’t already open).

Consider the formula in cell B9.

Click onto cell B9 and view the formula displayed in the formula
bar (the formula bar is at the top right of the screen grab below).

B9 . fr  =SUM(B4:BS)
A B C D E F G
1 Sales and Profit Report - First Quarter 2016
2 Formula Bar
3 Jan Feb Mar Average Maximum
4 Mew York 22,000 23,000 15,000 23,333 29,000
5 Los Angeles 42,000 35,000 43,000
& | Londan 18,000 20,000 22,000
T | Paris 35,000 26,000 31,000
E | Munich 12,000 15,000 13,000
9 |sales [[129.000]

The formula is =SUM(B4:B8). AutoSum created it for you in:
Lesson 2-3: Use AutoSum to quickly calculate totals. The formula uses
the SUM() function to add together the values in the range B4:BS.

Think about the formula that would work in cell C9 (the total sales
for February). It would be: =SUM(C4:C8). Similarly the formula
that would work in cell D9 (the total sales for March) would be
=SUM(D4:D8).

As you move to the right, all that is needed is to increment the
letter for each cell reference in the formula and you’ll get the right
answer every time.

AutoFill is very clever and realizes this. When you AutoFill a cell
containing a formula to the right, AutoFill increments the letters in
each cell reference.

Most of the time that is exactly what you want.

There’s also a way to fine-tune the way in which AutoFill adjusts
cell references, allowing you to implement some more advanced
AutoFill techniques. While this is beyond the scope of this Basic
Skills book, it is covered in-depth in the Essential Skills book in this
series (in Lesson 3 11: Understand absolute and relative cell references,
and Lesson 3 12: Understand mixed cell references).

AutoFill cell B9 to the right as far as cell D9.

You learned how to do this in: Lesson 2-14: Use AutoFill for text and
numeric series.
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E

Average
23,333
41,333
20,000
30,667
13,333

F

haximurm
25,000
43,000
22,000
35,000
15,000

You may see a row of hashes in cell C9 and/or D9. This is because
the value may be too wide to fit in the cell. If this is the case,
AutoFit the column using the skills learned in: Lesson 2-9: Re-size
rows and columns.

The correct answers for Feb and Mar sales are shown on the
worksheet. Click on the Feb total cell (C9) and look at the formula
in the formula bar.

o) . fx  =SUM(C4:C8)
A B C D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Average
4 | MNew York 22,000 25,000 15,000 23,333
5 Los Angeles 42,0040 35,000 43,000
& | London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
8 | Munich 12,000 15,000 13,000
9 |5-3|ES 129,000 | 129,000 _I 128,000

You can see that AutoFill has done its job perfectly, creating the
sum of the values in cells C4:C8. The five branches have sold
exactly the same amount in both January and February, but a little
less in March.

Consider the formula in cell E4.

Click onto cell E4 and view the formula displayed in the formula
bar.

i

E4 . fr  =AVERAGE(B4:D4)
A B C D E

1 Sales and Profit Report - First Quarter 2016

2

3 Jan Feb MWar Average

4 | New York 22,000 25,000 15,000 23,333 L

5 | Los Angeles 42,000 35,000 43,000

& |London 18,000 20,000 22,000

The formula is =AVERAGE(B4:D4). AutoSum created it for you in:
Lesson 2-11: Use AutoSum to quickly calculate averages.

Think about the formula that would work in cell E5 (the average
sales for Los Angeles). It would be: =AVERAGE(B5:D5). Similarly
the formula that would work in cell E6 (the average sales for
London) would be =AVERAGE(B6:D6).

As you move downward, all that is needed is to increment the
number for each cell reference in the formula. This is exactly what
AutoFill will do.

AutoFill cell E4 down to E8 to see the average sales for each
branch.

AutoFill cell F4 down to F8 to view the maximum sales for
each branch.

Save your work as First Quarter Sales and Profit-10.
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Lesson 2-16: Use AutoFill
options

Sometimes AutoFill begins to misbehave and actually gets in the way of
efficient work by wrongly anticipating what you need.

1 Open First Quarter Sales and Profit-10 from your sample
files folder (If it isn’t already open).

2 Populate cells F18 to F24 with sequential dates beginning
with 1-Jan-16 using AutoFill.

1. In cell F18, type the date: 1-Jan-16
2. AutoFill cell F18 down as far as cell F24.

The cells are populated with sequential dates:

A B C D E F
18 | Monday 1 9 01-Jan-16 Adjusted d1-lan-16
19 | Tuesday 2 18  02-lan-16 Adjusted J2-lan-16
20 | Wednesday 3 27  03-lan-16 Adjusted 03-lan-16
21 | Thursday 4 36  04-lan-16 Adjusted 04-lan-16
22 | Friday 5 43 03-Jan-16 Adjusted J5-lan-16
23 | Saturday ] 54  06-lan-16 Adjusted 06-Jan-16
24 | Sunday 7 63  07-lan-16 Adjusted d7-lan-16

3 Populate cells G18 to G24 with the date 37-Mar-16 using the
AutoFill Smart Tag.

1. In cell G18 type the date: 31-Mar-16
2. AutoFill down as far as cell G24.

At some time, you'll need to add transaction dates to a
worksheet and will have four or five entries with the same
date.

AutoFill is perfect for eliminating the need to re-type the date
for each transaction, but its insistence upon incrementing the
date every time could be very frustrating.

Fortunately, you can change the default behavior.

3. Click the Auto Fill Options Smart Tag I:I at the bottom right
corner of the filled cells.

05-Apr-16
06-Apr-16

-

Copy Cells
« Fill Series
Fill Formatting Only
Fill Without Formatting
Fill Days
Fill Weekdays
Fill Months
Fill Years

First Quarter Sales and 4. Click Copy Cells to tell AutoFill not to increment the date.
Profit-10
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4 Understand AutoFill options.

The Fill Formatting option is beyond the scope of this Basic Skills
book but is covered in-depth in the Essential Skills book in this
series (in Session Four: Making Your Worksheets Look Professional).

Here’s what the other options will do:

Copy Cells  Fill Series  Fill Days Fill Weekdays Fill Months Fill Years
This is what The default | The date Because 1+t April | Normally this would | The same
you just did. for dates that | increments 2016 was a show the same day calendar day
The first cell is include the by one day at | Friday, the number for each is shown for
. day. a time. weekend days month. In this each
copied to the tted and le th b ;
other cells. The date are omitted an example, there are subsequen
. the series jumps | only 30 days in three | year.
increments .
from 1¢t April to | of the months so 30t
by one day at . . .
. 4% April. is shown instead of
a time.
31st.
31-Mar-16 31-Mar-16 31-Mar-16 31-Mar-16 31-Mar-16 31-Mar-16
31-Mar-16 01-Apr-16 01-Apr-16 01-Apr-16 30-Apr-16 31-Mar-17
31-Mar-16 02-Apr-16 02-Apr-16 04-Apr-16 31-May-16 31-Mar-18
31-Mar-16 03-Apr-16 03-Apr-16 05-Apr-16 30-lun-16 31-Mar-13
31-Mar-16 04-Apr-16 04-Apr-16 06-Apr-16 31-Jul-16 31-Mar-20
31-Mar-16 03-Apr-16 05-Apr-16 07-Apr-16 31-Aug-16 31-Mar-21
31-Mar-16 06-Apr-16 06-Apr-16 08-Apr-16 30-Sep-16 31-Mar-22
note

AutofFill bug

You may encounter a bug that
takes you back to the Excel start
screen when you try to AutoFill
using the right-click menu.

This bug affects Excel version
15.37 and should be fixed in a
future update.

Copy Cells

Fill Series

Fill Formatting Only
Fill Without Formatting

Fill Days

Fill Weekdays
Fill Months
Fill Years

Series...

5 Populate cells F18 to F24 with sequential dates using a right-
click AutofFill.

1. Click on cell F18 to make it the active cell.

2. AutoFill down to cell F24, but this time hold down the right
mouse button instead of the left mouse button.

When you release the mouse button, you are instantly
presented with the AutoFill options (see sidebar).

This method is preferred to the Smart Tag method because it is
faster (one click instead of two).

3. Click: Fill Series or Fill Days.

In this example Fill Series and Fill Days produce exactly the
same result.

6 Save your work as First Quarter Sales and Profit-11.
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First Quarter Sales and
Profit-11

Lesson 2-17: Speed up your
AutoFills and create a custom
fill series

In this lesson you're going to learn some advanced AutoFill techniques
that will massively speed up your efficient use of the AutoFill feature.

1

2

3

Open First Quarter Sales and Profit-11 (if it isn’t already
open).

Use an AutoFill double-click to populate cells G19:G24 with
sequential dates.

1.

Delete the contents of cells G18:G24.
2. Type: 31-Mar-16 into cell G18.

A
18 I Monday
1% Tuesday
20 | Wednesday
21  Thursday
22 |Friday
23 | Saturday
24 | Sunday

L I =2 T ¥ B W R N T T

.
\_

D E

01l-Jan-16 Adjusted
02-Jan-16 Adjusted
03-lan-16 Adjusted
D4-lan-16 Adjusted
05-lan-16 Adjusted
06-lan-16 Adjusted
07-lan-16 Adjusted

F G
01-Jan -1I3| 31-Mar -IGI
02-lan-16
03-lan-16
04-lan-16
05-lan-16
0&-lan-16
a7-lan-16

Double click the AutoFill handle to automatically fill cells

G19:G24.

Hover over the AutoFill handle (the black spot at the bottom
right hand corner of cell G18). When you are sure that you
have the correct black cross cursor shape, double click to

automatically fill down to the end of the range.

A

18 | Monday

15 | Tuesday

20 |'Wednesday
21 Thursday
22 |Friday

23 | Saturday

24 | Sunday

B

L I =< T ¥ BRI T I N I

L

D E

01-lan-16 Adjusted
02-lan-16 Adjusted
03-lan-16 Adjusted
04-lan-16 Adjusted
03-lan-16 Adjusted
0&-lan-16 Adjusted
07-lan-16 Adjusted

F G
01-lan-16 31-Mar-16
02-lan-16| 01-Apr-16
03-lan-16 02-Apr-16
04-lan-16| 03-Apr-16
05-lan-16| 04-Apr-16
Q&-lan-16| O5-Apr-16
07-lan-16 0&-Apr-16

Create a custom list containing the values: North, South,
East and West.

Click: > Excel>Preferences=> Custom Lists.

1.

The Custom Lists dialog appears.

Click in the List entries box and add four custom list entries:
North, South, East and West, pressing the <Enter> key

between each item.



Session Two: Doing Useful Work with Excel

Q
g Show All (:‘:\
List entries: Custom lists:
MNorth NEW LIST
South Men, Tue, Wed, Thu, Fri, Sat, Sun
iiséﬂ Monday, Tuesday, W...y, Saturday, Sunday
Add Jan, Feb, Mar, Apr,..g, Sep, Oct, Nov, Dec

Press Return to separate list entries.

Impaort list from cells:

Custom Lists

January, February,...November, December

B Import

3. Click the Add button to add the new custom list.
4. Click the Close button to close the Custom Lists dialog.

Use the newly-created custom list.
Type North into any cell and AutoFill down.

As you AutoFill, the custom list entries appear in the worksheet.

Morth
South
East
West
Morth
South
East
West

Delete the North, South, East, West... cells from the
worksheet.

Save your work as First Quarter Sales and Profit-12.
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note

Can my mouse be
used to zoom?

The first Apple mouse to
include a scroll wheel was the
Mighty Mouse, first released in
2005. If you are using an Apple
mouse from before 2005, you
won’t be able to zoom in and
out using the mouse.

Apple’s most recent mouse (the
Magic Mouse) does not include
a scroll wheel, but instead
allows you to scroll by holding
your finger on the mouse’s
surface and then moving it in
the direction that you wish to
scroll.

Any other mouse that has a
scroll wheel should allow you
to zoom as shown in this
lesson. You do not need to use
an Apple mouse.

note

If mouse zooming
doesn’t work

You might find that mouse
zooming doesn’t work, even
though you have a Magic
Mouse or a mouse with a scroll
wheel. This may be due to a
bug in Excel for Mac.

Excel sometimes gets confused
over whether you are trying to
scroll within the workbook or
trying to scroll through items in
menus on the ribbon.

If this happens to you, you
should be able to fix the
problem by quitting and
restarting Excel.

You saw how to do this in:
Lesson 1-5: Minimize, re-size,
move and close the Excel window.

First Quarter Sales and
Profit-12

Lesson 2-18: Use the zoom
control

Zooming is used to magnify or reduce the worksheet. If you have a lot of
rows in a worksheet and have good eyes, you might want to zoom out
sometimes to see more of the worksheet on one screen.

1 Open First Quarter Sales and Profit-12 from your sample
files folder.

2 Zoom in and out of the worksheet using the mouse.

The fastest way to zoom a worksheet is by using the mouse, if your
mouse has this ability (see sidebar).

To zoom using the mouse, hold down the <Ctrl> key on the
keyboard and roll the mouse wheel to zoom in and out.

3 Zoom in and out of a worksheet using the zoom control.
The zoom control is at the bottom right of your screen.

Click and drag on the zoom control slider to zoom in and out of
your worksheet. You can also zoom by clicking the plus and minus
buttons on either side of the Zoom control.

Zoom Zoom in

out ciick and

drag to
n Click here 10

il display the
A 'y + 100% 4— Z00Mm dlalog

4 Use the Zoom dialog to make cells A3:D9 fill the screen.
1. Select cells A3:D9.

A B C D E

2

3 Jan Feb Mar Average
4 | New York 22,000 29,000 19,000 23,333
5 |Los Angeles 42,000 35,000 43,000 | 41,333
& |London 18,000 20,000 22,000 20,000
7 | Paris 35,000 26,000 31,000 30,667
8 |Munich 12,000 15,000 13,000 13,333
9 |sales 129000 | 1259000 | 128,000 |

2. Click on the right hand side of the zoom bar.

-  » +

LT

Zoom level. Click to open the Zoom dialog box.

The Zoom dialog is displayed.
3. Select the Fit Selection option button.
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Zoom
note
. Zoom to:
The Zoom dialog can 200%
also be accessed 150%
using the Menu Bar 125%
100%
You can also access the Zoom
dialog by clicking: 75%
50%
®->View>Zoom... 2587
O Fit selection
Custom: |400 | %
cance! | (CINN

4. Click the OK button.

The worksheet is zoomed so that the selected cells completely
fill the screen.

M & » - J ~ 5 First Quarter Sales and Profit-12 Q- ©-
Insert Page Layout Formulas Data Review View &% Share ~
= — Congitional Formatting = 14=b1
wf " % o R =" (%)v i‘Forma(asTablc' : ._' Q'
Paste %:‘ Font Alignment Number 7 Cell Styles - Cells Editing
Clipboard Styles
Al : fx salesand Profit Report - First Quarter 2016 v
A B (& D E
3 Jan Feb Mar Average
4 New York 22,000 29,000 19,000 23,333
5 Los Angeles 42,000 39,000 43,000 41,333
6 London 18,000 20,000 22,000 20,000
7 Paris 35,000 26,000 31,000 30,667
8 Munich 12,000 15,000 13,000 13,333
9 Sales 125,000 129,000 128,000
4 » Sheet1 Sheet2 Sheet3 +
Ready LT izl [ - . + 189%

5 Zoom back to 100% using the ribbon.

You'll probably find the zoom bar to be the quickest and most
convenient way to zoom, but you can also zoom using the ribbon.

Click: View—>Zoom—>Zoom to 100%.

Zoom 240% v

@, zoom to 100%

Loom

100%

The screen is restored to normal size.
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First Quarter Sales and
Profit-12

Lesson 2-19: Print out a
worksheet

You aren’t going to explore every option for preparing and printing a
worksheet in this lesson. Printing is such a huge subject that a whole
session is dedicated to it in the Essential Skills book in this series (in
Session Seven: Printing Your Work).

This lesson only aims to teach you the bare minimum skills you need to
put your work onto paper.

1

Open First Quarter Sales and Profit-12 from your sample
files folder (if it isn’t already open).

A B c D E F G
1 Sales and Profit Report - First Quarter 2016
2
E | Jan Feb har Average | Maximum
4 | Mew York 22,000 25,000 15,000 23,333 25,000
5 Los Angeles 42,000 35,000 43,000 41,333 43,000
& | London 18,000 20,000 22,000 20,000 22,000
7 | Paris 35,000 26,000 31,000 30,667 35,000
E | Munich 12,000 15,000 13,000 13,333 15,000
9 | Sales 129,000 129,000 128,000
10
11 Costs 83,000
12 | Profit 46,000
13 | 10% Bonus 4,600
14
15 |USA Sales " 64,000
16 |European Sales | 65,000
17
18 | Monday 1 9 0l-lan-16 Adjusted 0l-lan-16 31-Mar-16
19 | Tuesday 2 18  02-lan-16 Adjusted 02-lan-16 Ol-Apr-16
20 | Wednesday 3 27  03-lan-16 Adjusted 03-lan-16 02-Apr-16
21  Thursday 4 36  04-lan-16 Adjusted 04-Jan-16 03-Apr-16
22 |Friday 5 45  03-lan-16 Adjusted 03-lan-16 04-Apr-16
23 | Saturday & 54  0&-lan-16 Adjusted 06-lan-16 035-Apr-16
24 | Sunday 7 63  07-lan-16 Adjusted 07-lan-16 0&-Apr-16

Click: «>File=>Print.

The Print dialog appears, showing a preview of how the document
will print. By default, a simplified version of the dialog is shown.

Click Show Details to show the complete Print dialog.

-

7 PDF H Show Details A

The complete dialog is shown, enabling you to access more
printing options.

If the complete dialog is already visible, the Show Details button
will be replaced by a Hide Details button.
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Preview of how the page
will look when printed

v

1of1

A

Move to a different page

PDF H Hide Details

Send the worksheet to the printer

Select Printer

Print

Printer: | hp LaserJet 2420 UPD PCL 6 d

Presets: Default Settings d

Copies: 1

Pages: @ All

From: |1 to: 1

Paper Size: A4 Ii 210 by 297 mm

Orientation: | T f Toe

Exce ﬁ
@ cCollate pages
Print: = Active Sheets d
Margins: = MNormal Margins ﬁ
Scale to fit:

Print Optio‘r';s

Cance

fﬁ

4 Print the worksheet.
Click the Print button:

i

The page is printed on the selected printer.
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1 Open a new blank workbook.
2 Use AutoFill to put the three months Jan, Feb, and Mar into cells A4:A6.
3 Using only the keyboard, add the following data:
A B C D E
1 |Profit Analysis
2
3 London Paris Mew York  Average
4 lan 2,500 3,100 2,300
5 |Feb 2,200 2,700 2,600
& Mar 2,100 2,600 2,800
7 | Total
4 Use AutoSum to compute London’s total profit for Jan/Feb/Mar in cell B7.
5 Use AutoSum to compute the average January profit in cell E4.
6 Use AutoFill to extend the London total in cell B7 to the Paris and New York totals in cells C7 and
D7.
7 Use AutoFill to extend the January average profit in cell E4 to the February and March average
profits in cells E5 and E6.
8 Select all of column A and all of column E (at the same time) and bold face the values in them.
9 Select rows 3 and row 7 (at the same time) and bold face the values in them.
A B C D E
1 |Profit Analysis
2
3 London Paris New York  Average
4 Jan 2,500 3,100 2,300 2,633
5 Feb 2,200 2,700 2,600 2,500
& |Mar 2,100 2,600 2,800 2,500
7 Total 6,800 8,400 7,700
10 Select cells B4:B6 and cells D4:D6 at the same time and then read the total London and New York
sales figure for Jan, Feb and March from the summary information displayed on the status bar.
11 Select cells B4:D6 and zoom the selection so that these cells fill the screen.
12 Save your work as Exercise2-End.

If you need help
slide the page to
the left
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These are the questions that students find the most difficult to answer:

Q10

1. Hover over the center of

cell B4 so that you see the
white cross cursor shape.

I G 2,5001

2. Click and drag down to
cell B6.

3. Hold down the <Cmd>
key.

4. Hover over cell D4 until

you see the white cross
cursor shape.

5. Click and drag down to
cell D6.

6. Look at the status bar at

the bottom right of the
screen.

This was covered in: Lesson

2-7: Select non-contiguous
cell ranges and view
summary information.

Q8

1. Click on the column
A header.

oA B

1 | Praofit Anal'.rs_ls

2. Hold down the
<Cmd> key.

3. Click on the column E
header.

4. Click:
Home—->Font>Bold

Calibri {Body); - 12
B I H v
L

Font

This was covered in:
Lesson 2-6: Select adjacent
and non-adjacent rows
and columns.

Q4

1. Click in cell B7.
2. Click:

Home->Editing—>
AutoSum

F AutoSum -

@ Fill »

C? Clear =

Editing

A

Z Y-
Sort &
Filter

3. Press the <Enter> key.

This was covered in:
Lesson 2-3: Use AutoSum
to quickly calculate totals.

Q2

1. Type Jan into cell
A4 and press the
<Enter> key.

2. Click cell A4 once
to make it the active
cell.

3. Hover the mouse
cursor over the
bottom right corner
of the cell until you
see the black cross
cursor shape.

Jan

4. Click and drag
down to cell A6.

This was covered in:

Lesson 2-14: Use
AutoFill for text and
numeric series.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

= = O N O O W =

N =

Refer to: Lesson 1-2: Start Excel and open a new blank workbook.

Refer to:
Refer to:
Refer to:
Refer to:
Refer to:
Refer to:

Refer to:

Lesson 2-18: Use the zoom control.

Lesson 2-1: Enter text and numbers into a worksheet.
Lesson 2-3: Use AutoSum to quickly calculate totals.
Lesson 2-15: Use AutoFill to adjust formulas.
Lesson 2-15: Use AutoFill to adjust formulas.

Lesson 2-6: Select adjacent and non-adjacent rows and columns.

Lesson 1-8: Save a workbook to a local file.
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Index

alt key, 28
apple
mouse, 18
arrange all, 60
Autocomplete
formula entry using, 82
AutoFill
custom fill series, creating, 90
date series, examples of, 88
formulas, using to adjust, 86
smart tag options, using, 88
text and numeric series, creating with, 84
AutoFit rows and columns, 75
automatic updates
applying, 22
switching on and off, 22
AutoSum, 62
AVERAGE functions, creating with, 78
MAX functions, creating with, 78
SUM a non contiguous range with, 76
AVERAGE function, 78

backstage view, 44
binary workbook format, 34

c_

cancel button, 58
cells
active cell, 72
deleting, 78
entering text into, 58
entering values into, 58
selecting a range of, 65
selecting all in a worksheet, 75
check box, 42
close button, 26
columns
making several the same size, 75
resizing automatically, 74
selecting, 68
selecting non contiguous, 68
width of, manually changing, 75
confirm button, 58

currency
prefixes, 59

cursor shapes, explained, 65

custom lists, 90

documents. See also files
organization of, 36
pinning, 36
downloading the sample files, 11, 30
drop-down list, 42

editing cell contents, 58
Excel 97-2003 workbook format, 34
Excel workbook file format, 32, 34

F1-F12 keys, 70
files. See also workbooks; documents
formats supported, 32, 34
opening with earlier Excel versions, 34
organization of, 36
fill. See AutoFill
fn key, 70
formula bar
explanation of, 64
graphic showing location of, 32
showing and hiding, 48
formulas
Autocomplete, creating with, 82
AutoFill, adjusting with, 86
AVERAGE function, creating using AutoSum,
78
F2 key to display range addressed by, 79
formula bar, viewing in, 64
MAX function, creating using AutoSum, 78
mouse selection, creating with, 80
multiplication operator (*) using in, 81
SUM function, creating using AutoSum, 62
syntax box, understanding, 82
visual keyboard technique, creating with, 81
fractions, entering into cells, 59
full screen view, 28
functions
AVERAGE, 78



Index

MAX, 78
SUM, 62, 76

gallery, 42
goto special, 73

help system
execute command, using to, 50
searching, 50

keyboard
alt key, 28
F1-F12 keys, 70
fn key, 70
option key, 28
keyboard shortcuts
AutoSelect a range, 73
AutoSum, 62
bold, 68
close, 26
cycle through worksheets, 39
full screen view, 28
italic, 68
mission control, 60
quit, 26
ribbon, show/hide, 40
save, 32
save as, 32
select every cell in a worksheet, 74
underline, 68
workbook, create new, 60

macro enabled workbook format, 34

magic mouse, 18

Magic Mouse, 92

marching ants, 62

marquee, 62

MAX function, creating using AutoSum, 78

menus
shortcut (contextual), 18
standard, 42

microsoft autoupdate, 22

mighty mouse, 18

minimize button, 26

mouse

configuring, 18

right clicking, 18

scroll wheel, 92

zooming with, 92
moving

the Excel window, 26
multiplication operator (*), 81

name box, 30

negative numbers, entering into cells, 59
normal view, 46

number sign (#), 74

office insider program, 22
office theme, changing, 24
office version

checking Excel version, 22
OneDrive

save a workbook to, 32
option key, 28
organizing

excel files, 36

sample files folder, 30

page layout view, 46
PDF, workbook format, 35
pound sign (#), 74
printing
previewing on screen, 44, 46

quick access toolbar
adding commands to, 44
adding separators to, 44
deleting commands from, 44
quit excel, 26
quotations
Aristotle, 42
Confucius, 5
Euripides, 17
Robert Collier, 26
Winston Churchill, 4

ranges
AutoSelect, selecting automatically with, 72

© 2018 The Smart Method Ltd

101



Learn Excel 2016 for Mac OS X Essential Skills with The Smart Method

copying data across, 66
entering data into, 66
non contiguous, selecting, 70
select all button, to select a range containing
every cell in a worksheet, 75
selecting, 64
selecting visually for formulas with the mouse,
80
restore down button, 26
ribbon
benefits of wide screen with, 40
command groups on, 42
contextual tabs, explanation of, 41
controls on, 42
font panel controls, explanation of, 41
overview, 40
showing and hiding (minimizing), 41, 48
rows
making several the same size, 75
manually setting height of, 75
resizing automatically, 74
selecting, 68
selecting non contiguous, 68

sample files
downloading, 11, 30
organizing folder, 30
save, 32, 34
selecting cells, 64
smart tag
explained, 64
options, 88
split button, 42
start Excel, 20
SUM function
creating manually using formula
AutoComplete, 82
creating using AutoSum, 62
switch windows, 60

tabs. See worksheets
templates
using, 20

the smart method
learning by participation, 5
two facing pages rule, 4
themes. See also office theme
title bar, 60

values
currency prefixes, using with, 59
entering into cells, 58
fractions, entering into cells, 59
negative numbers, entering into cells, 59

windows
arrange all, using to automatically size, 60
closing, 26
maximizing, 28
minimizing, 26
moving, 26
resizing, 26
restoring, 26
switching to view a different workbook, 60
workbooks. See also files
changing default number of worksheets in, 38
creating new, 60
opening, 30
saving, 32, 34
switching between open workbooks, 60
viewing two at the same time, 60
views, 46
worksheets
adding, 38
changing default number of, 38
chart worksheets, explanation of, 38
deleting, 38
maximum number of rows and columns in, 30
navigating, 30, 38
renaming, 38
tab colors, changing, 39

zoom button, 26, 28
zoom control, 92



Moving to the next level

Learn

Excel 2016 &%
Essential Skills
With The Smart Method

Mike Smart

The next book/e-book in this series (Essential
Skills) builds upon the basic skills you’ve
already learned.

When you have completed this book/e-book you will have
excellent Excel skills, good enough to impress any employer,
and your Excel skills will be better than most office workers
(even those with many years of experience).

You'll be able to create beautifully laid-out worksheets that
will really impress and will have completely mastered all of
Excel’s charting features.

The paper printed book is always in stock at Amazon.

The e-book is published in unlocked, printable PDF format
(just like this basic-skills e-book) and is only available from:
https://thesmartmethod.com (this is the publisher’s own web
site).

Learn

Excel 2016 5:X*°
Expert Skills
With The Smart _Me hod

Mike Smart

The last book in the series (Expert Skills)
covers only the most advanced Excel features.

This book will give you advanced Excel skills that are rarely
mastered by the average user. By the end of the book you’ll
be a true Excel expert, able to use all of the power available
from the world’s most powerful business tool.

Your Excel skills will be greater and broader than almost all
other Excel users in the workplace.

The paper printed book is always in stock at Amazon.

The e-book is published in unlocked, printable PDF format
(just like this basic-skills e-book) and is only available from:
https://thesmartmethod.com (this is the publisher’s own web
site).

About our e-books

READ ON ANY DEVICE

Every popular web browser and -book
books can be read on just about any

and installing reader software.

reader can open & PDF file. Our POF e-

device without having the bother of finding

Our e-books are not
locked with DRM (digital
rights management)

You can legally print
your e-book for your
own personal use.
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Excel 201 6 for Windows
Construction Kit #1

Calendar and Year Planner

construction kit you'll leam how to use and apply advanced
| skills to construct a robust Excel business application that would be
nd the powers of most advanced Excel users.

nstruct the appiication, you'll learn advanced Excel techniques
vill be able to apply in the future to a mulfitude of Excel business
problems.

The companion Web site has sample files )
at: http-//ExcelCentral.com Mike Smart

Learn how to apply your new Excel skills with a
Smart Method construction kit

For over 900 years craftsmen have traditionally taught their
skills to an apprentice. In this model the apprentice learned
his trade by observing how the master craftsman used his
skills. This construction kit will teach you advanced Excel
skills in the same way. Even if you only have basic Excel
skills, the construction kit is designed in such a way that
you'll be able to construct a complex, polished professional
Excel application that would be well beyond the powers of
most advanced Excel users. Available as both a printed paper
book and e-book.

Preview the first chapter free at:

https://thesmartmethod.com

Excel Challenges

VLOOKUP,
Function

Test Your Excel skills

Challenges are graded to
Basic, Essential and Expert level

Excel Challenges

Our Excel online challenges are a little like the exercises at the
end of each session in this book. Unlike the exercises, the
online challenges will test the application of many skills
(covered in different sessions in the book).

We began trialling challenges in July 2018 and (at time of
writing in August 2018) we have published three challenges
but by the time you read this book we may have produced
more.

Access the challenges online at:

https://thesmartmethod.com/excel-challenges/



https://thesmartmethod.com/
https://thesmartmethod.com/excel-challenges/

Use your new Excel skills to teach your
own classroom courses

If you’ve worked through this book carefully you will now have excellent Excel skills and if you progress to
the Expert Skills book in the series, you'll be a true Excel expert. There is a huge demand, everywhere in the
world, for Excel training at all levels. The skills you have learned in this book will enable you to teach an
introductory Excel course (providing all of the skills needed by most office workers).

We can directly and rapidly supply books, at educational discount prices, to Excel instructors, corporate
clients, schools, colleges and universities from our warehouses in the USA (also serving Canada), UK (also
serving Europe) and Australia (also serving New Zealand).

Our books are printed in the USA, UK, Australia, Germany, Italy, Spain, Brazil, Poland, South Korea, China,
India, and Russia so are instantly available, in almost every country in the world, by simply quoting the
ISBN number (shown below) to any bookseller or wholesaler.

Use our books to teach all Excel versions

This book is available for all Excel versions in common use (Excel 2007, 2010, 2013, 2016 for Windows and
2016 for Apple Mac). This means that you'll be able to teach Excel classes even if the client uses an
earlier/later version or uses Apple computers. You can use the books as courseware during your classes and
then give each student a copy of the book to take home as reference material when the course is over.
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You can quote the ISBN numbers shown above to any book retailer or wholesaler. All major distributors (in
every country of the world) have our books in stock for immediate delivery.

Place a direct order for 5+ books for
wholesale prices and free delivery

To place a publisher-direct order you only need to order five books or more (of the same title). To view
wholesale prices, go to this web page:

https://thesmartmethod.com/wholesale-printed-books
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